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Abbreviations in This Document 
A list of abbreviations used in this document. 

Abbreviation Definition 

ASCII American Standard Code for Information Interchange 

BSP 
Board Support Package. The layer of software containing hardware-specific drivers and libraries to function 
in a particular hardware environment. 

CXU Composable Extension Unit 

CDT C/C++ Development Tools 

CLINT Core Local Interruptor 

CNN Convolutional Neural Network 

CPU Central Processing Unit 

DUT Design Under Test 

GUI Graphical User Interface 

XIP  Execute in Place 

FD-SOI Fully-Depleted Silicon On Insulator 

FMC FPGA Mezzanine Card 

FPGA Field Programmable Gate Array 

FreeRTOS A market-leading RTOS for microcontrollers and small microprocessors 

FTDI Future Technology Devices Intl.Ltd  

GPTIMER General-Purpose Timer 

GRUB Grand Unified Bootloader  

HDL Hardware Description Language 

HPC High Pin Connector 

IBIS Input Output Buffer Information System 

IDE Integrated Development Environment 

I2C Inter-Integrated Circuit 

IP Intellectual Property 

ISR Interrupt Service Routine 

JEDEC Joint Electron Device Engineering Council 

JTAG Joint Test Action Group 

MCU Micro-Controller Unit 

MSIP Machine-Mode Software Interrupt 

OCD On-Chip-Debugging 

OEM Original Equipment Manufacturer 

OpenOCD Open On-Chip Debugger 

OS Operation System 

PC Personal Computer 

PIC Programmable Interrupt Controller 

PLIC Platform-Level Interrupt Controller 

PMOD Peripheral Module 

QEMU A generic and open-source machine emulator and virtualizer 

RAM Random-Access Memory 

RISC-V 
Reduced Instruction Set Computer-V. A free and open instruction set architecture (ISA) enabling a new era 
of processor innovation through open standard collaboration. 

RISC-V MC Lattice RISC-V for Micro-Controller Soft IP 

RISC-V RX Lattice RISC-V for RTOS Soft IP 

RISC-V SM Lattice RISC-V for State-Machine Soft IP 

RTOS Real Time Operating System 
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Abbreviation Definition 

RX RISC-V for RTOS applications  

SDK 
Software Development Kit. A set of software development tools that allows the creation of applications for 
software package on the Lattice embedded platform. 

SHA Secure Hash Algorithm 

SoC 
System-on-Chip. An integrated circuit that integrates all components of a computer or other electronic 
systems. 

SPI Serial Peripheral Interface 

SRAM Static Random Access Memory 

UART Universal Asynchronous Receiver/Transmitter 

UFM User Flash Memory 

UI User Interface 

VHDL Very-High-Speed Integrated Circuit Hardware Description Language 

WDT Watch Dog Timer 
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1. Introduction 
Lattice Propelϰ design environment is a complete set of graphical and command-line tools to create, analyze, compile, 
and debug both FPGA-based hardware and software processor systems. 

1.1. Purpose 
Embedded system solutions play an important role in FPGA system design, allowing you to develop software for a 
processor in an FPGA device. It provides the flexibility for you to control various peripherals from a system bus.  

To develop an embedded system on an FPGA, you need to design the System-on-Chip (SoC) with an embedded 
processor and develop system software on the processor. Lattice Propel helps you develop your system with a RISC-V 
processor, peripheral IP, and a set of tools.  

The purpose of this document is to introduce Lattice Propel SDK tool and flow to help you quickly get started to build a 
small demo system. You can find recommended flows of using Lattice Propel SDK in this document as well.  

1.2. Audience 
The intended audience for this document includes embedded system designers and embedded software developers 
using Lattice FPGA devices. The complete list of supported devices can be found in Lattice Propel Release Notes. The 
technical guidelines assume readers have expertise in the embedded system area and FPGA technologies. 
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2. Lattice Propel Development Suite 
Lattice Propel development suite includes: 

¶ an integrated development environment (IDE), which is the framework of the Lattice Propel design suite;  

¶ Lattice Propel Builder, which is for SoC design;  

¶ Lattice Propel SDK, which is for system software development. 

2.1. Eclipse IDE 
Eclipse IDE provides the Lattice Propel development suite a platform to manage the SoC project and the Embedded 
C/C++ Project in the same workspace.  

The SoC project, which extends from the Lattice Propel Builder project, provides easy interaction with other Lattice 
design tools, such as the Lattice Diamondϰ software within Lattice Propel design environment. 

The Embedded C/C++ Project provides a platform for developing or debugging application code within Eclipse IDE. The 
project can be created directly from the SoC project with a pre-set Board Support Package (BSP) and applications by 
using the Lattice Propel development suite. 

2.2. Lattice Propel Builder 
Lattice Propel Builder allows you to assemble the larger functional blocks of the design hierarchy. Lattice Propel Builder 
enables you to instantiate modules and IP from the IP Catalog in a schematic view, and can easily connect the modules. 
Lattice Propel Builder also helps you customize address spaces within modules, such as a processor. In the Lattice 
Propel development suite, Lattice Propel Builder is used to create a microprocessor integrated platform for both 
hardware and software development.  

Refer to Lattice Propel Builder 2025.2 User Guide (FPGA-UG-02243) for more detailed information. 

2.3. Lattice Propel SDK  
Lattice Propel SDK is based on Eclipse Embedded C/C++ Development Tools (CDT). It allows you to create, build, and 
debug software application projects that drive the platform within the Eclipse framework. 

The main features are: 

¶ Create, build, debug, or manage embedded applications for Lattice RISC-V CPU or SoC solution. 

¶ Provide extra build steps to generate the binary and memory files required for deployment. 

¶ Build using the latest industry standard open-source components and tools for RISC-V firmware development and 
debugging. 

¶ Support Picolibc for RISC-V and provide lightweight standard library implementation. 

¶ Provide fully-configurable toolchain definitions. 
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3. Lattice Propel Tool Flows 
The Lattice Propel tool flows including SoC project design flow, C/C++ project design flow, system simulation flow, and 
programming and On-Chip-Debugging (OCD) flow, are discussed in detail in the following sections. 

3.1. Lattice Propel Environment 

3.1.1. Running Lattice Propel 

After installing the Lattice Propel software, you can launch Lattice Propel SDK from the desktop shortcut icon or from 
the Windows Start menu. When Lattice Propel SDK is invoked, a dialog (Figure 3.1) pops up. You can browse to select 
where to locate the workspace. For normal needs, simply click Launch to pick the default location and continue running 
Lattice Propel SDK. 

 

Figure 3.1. Select Workspace Dialog 

After the workspace location is chosen, a single workbench window is displayed using default Lattice Propel SDK 
perspective. The default Lattice Propel SDK perspective contains the following five functional areas (Figure 3.2). 

Note: A perspective is a group of views and editors in the Workbench window. A workspace is the directory where 
stores your work and it is used as the default content area for your projects as well as for holding any required 
metadata. A workbench is the desktop development environment in Eclipse IDE platform. 
1. Menu bar and Toolbar, including: File menu, Edit menu, Source menu, Refactor menu, Navigate menu,  

Search menu, Project menu, Run menu, LatticeTools menu, Window menu, and Help menu. 

2. tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΥ ŘƛǎǇƭŀȅǎ ǇǊƻƧŜŎǘǎ ƛƴ ǘƘŜ ǿƻǊƪǎǇŀŎŜΦ 

3. 9ŘƛǘƻǊ ǾƛŜǿΥ ǇǊƻǾƛŘŜǎ ŎŀǇŀōƛƭƛǘȅ ƻŦ ŜŘƛǘƛƴƎ ǎƻǳǊŎŜ ŦƛƭŜǎΦ 

4. hǳǘƭƛƴŜ ǾƛŜǿΥ ŘƛǎǇƭŀȅǎ ŀƴ ƻǳǘƭƛƴŜ ƻŦ ŀ ŦƛƭŜ ǘƘŀǘ ƛǎ ŎǳǊǊŜƴǘƭȅ ƻǇŜƴ ƛƴ ǘƘŜ ŜŘƛǘƻǊ ŀǊŜŀΦ 

5. [ƻƎ ŀǊŜŀ ƛƴŎƭǳŘŜǎ ǘƘŜǎŜ ǾƛŜǿǎΥ tǊƻōƭŜƳ ǾƛŜǿΣ ¢ŀǎƪǎ ǾƛŜǿΣ /ƻƴǎƻƭŜ ǾƛŜǿΣ tǊƻǇŜǊǘƛŜǎ ǾƛŜǿΣ ŀƴŘ ¢ŜǊƳƛƴŀƭ ǾƛŜǿΦ  
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Figure 3.2. Lattice Propel Workbench Window 

3.1.2. Importing Lattice SoC Design Projects 

In Lattice Propel SDK, you can use the Import Wizard to import Lattice SoC design projects into workspace. Existing SoC 
design projects created by either Lattice Propel SDK or Lattice Propel Builder can also be imported into Workspace by 
choosing Lattice Propel > Lattice SoC Design Projects.  

1. From Lattice Propel SDK, choose File > LƳǇƻǊǘΧ.  

The Select wizard opens (Figure 3.3). 

2 3 

1 

4 

5 
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Figure 3.3. Select Wizard ς Import Lattice SoC Design Projects 

2. Select Lattice Propel > Lattice SoC Design Projects into Workspace. Click Next. 

The Select wizard switches to Import Lattice SoC Design Projects wizard page (Figure 3.4). 

http://www.latticesemi.com/legal


Lattice Propel 2025.2 SDK  
User Guide 
 

© 2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02244-1.0  16 

 

Figure 3.4. Import Lattice SoC Design Projects Wizard 

3. Locate the directory containing the projects by clicking the Browse button. 

4. In Projects area, select the SoC design project or projects you want to import. 

5. Click Finish to start the importing process. 

3.1.3. Importing Lattice C/C++ Projects 
In Lattice Propel SDK, you can use the Import Wizard to import existing Lattice C/C++ projects created by Lattice Propel 
SDK 2023.2 or later into workspace by choosing Lattice Propel > Lattice C/C++ Projects.  

1. From Lattice Propel SDK, choose File > LƳǇƻǊǘΧ.  

The Select wizard opens (Figure 3.5). 
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Figure 3.5. Select Wizard ς Import Lattice C/C++ Projects 

2. Select Lattice Propel > Lattice C/C++ Projects into Workspace. Click Next. 

The Select wizard switches to the Import Lattice C/C++ Projects wizard page (Figure 3.6). 

 

Figure 3.6. Import Lattice C/C++ Projects Wizard 
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3.1.4. Creating Customized C/C++ Templates 

In Lattice Propel SDK, you can select a Lattice C/C++ project in the current workspace to create a user application 
template for creating new Lattice C/C++ project.  

Note: You must use this template management function on Lattice Propel SDK 2024.2 or later. 
1. From Lattice Propel SDK, select a C/C++ project and choose Project > Create Lattice Application Template. The 

Create Application Template wizard opens Figure 3.7. 

 

Figure 3.7. Create Application Template ς General 

2. ¸ƻǳ Ŏŀƴ ƛƴǇǳǘ ¢ŜƳǇƭŀǘŜ ƴŀƳŜΣ 5ŜǎŎǊƛǇǘƛƻƴΣ ¢ƻƻƭŎƘŀƛƴ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΣ Lt {ŜǘǘƛƴƎǎΣ ŀƴŘ ǎƻ ƻƴΣ ŀƴŘ ǎŜƭŜŎǘ ŦƛƭŜǎ ŦƻǊ 
ŎǊŜŀǘƛƴƎ ǘŜƳǇƭŀǘŜΦ  

Notes:  

¶ Under the General tab (Figure 3.7), select project code files, all files except linker.ld are checked. It is 
recommended to keep these selections to avoid potential errors in building. 

¶ Under the IP Settings tab (Figure 3.8), Propel SDK generates a filter according to your settings. This means if 
you create a C/C++ project using this C/C++ template, the corresponding SoC project should include the 
versions of IPs shown in the IP Settings tab. Be careful when modifying the IP-related settings under this tab. If 
these settings are not set properly, you might encounter errors when using these templates on other versions 
of Lattice Propel SDK. 

3. /ƭƛŎƪ CƛƴƛǎƘΦ 
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Figure 3.8. Create Application Template ς IP Settings 

3.1.5. Exporting and Deploying Customized C/C++ Templates 

In Lattice Propel SDK, you can export customized C/C++ templates into a single ZIP archive that is ready for deployment 
in other ǳǎŜǊǎΩ Lattice Propel SDK environments.  

Note: You must use this template management function on Propel SDK 2024.2 or later. 

1. From Lattice Propel SDK, choose File > ExportΧ.  

The Select wizard opens (Figure 3.9). 

 

Figure 3.9. Select Wizard for Lattice Application Templates  

2. Select Lattice Propel > Lattice Application Templates. Click Next. 
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The Select wizard switches to the Export Lattice Application Templates wizard page (Figure 3.10). 

  

Figure 3.10. Export Lattice Application Templates Wizard 

3. You can locate the destination directory by clicking the Browse button. 

4. In the Application Name area, select the application templates you want to export. 

5. Click Finish to start the exporting process. 

The exported zip archive file is ready to be delivered to other Lattice Propel SDK users. 

6. With this zip archive file, extract it to the Application Templates Install Path in the userΩs environment. Select 
Window > Preferences > Propel Setting to find this setting (Figure 3.11). 

 

Figure 3.11. Lattice Propel Setting Page 
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3.2. SoC Project Design Flow 
A new SoC design project including a Lattice Propel Builder design can be started from the Lattice Propel sets. Follow 
steps below to create a new SoC design project. 

Note: The SoC project templates are gradually being migrated to the new scalable SoC project templates that are only 
available from Lattice Propel Builder. If the following flow for creating an SoC design project is unreachable, create it 
from Lattice Propel Builder. See Lattice Propel Builder 2025.2 User Guide (FPGA-UG-02243) for more details.  

3.2.1. Creating an SoC Design Project (Deprecated) 

To start a Lattice SoC design project from Lattice Propel SDK: 

1. Lƴ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΣ ŎƘƻƻǎŜ CƛƭŜ Ҕ bŜǿ Ҕ    [ŀǘǘƛŎŜ {ƻ/ 5ŜǎƛƎƴ tǊƻƧŜŎǘΦ  

¢ƘŜ /ǊŜŀǘŜ {ƻ/ tǊƻƧŜŎǘ ǿƛȊŀǊŘ ƻǇŜƴǎ όCƛƎǳǊŜ оΦмнύΦ Lƴ ǘƘŜ /ǊŜŀǘŜ {ƻ/ tǊƻƧŜŎǘ ǿƛȊŀǊŘΣ ȅƻǳ Ŏŀƴ ǎǇŜŎƛŦȅ ŀ ŘŜǾƛŎŜ ƻǊ ŀ 
ōƻŀǊŘ ŦƻǊ ŀ ¢ŜƳǇƭŀǘŜ {ƻ/ ǇǊƻƧŜŎǘΦ  

¶ ¢ƻ ǎǇŜŎƛŦȅ ŀ ŘŜǾƛŎŜ ŦƻǊ ȅƻǳǊ ƴŜǿ ¢ŜƳǇƭŀǘŜ {ƻ/ ǇǊƻƧŜŎǘΣ ǳǎŜ ǘƘŜ ŘǊƻǇπŘƻǿƴ ƳŜƴǳ ǘƻ ǎŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ŘŜǾƛŎŜ 
ƛƴŦƻǊƳŀǘƛƻƴΣ ƛƴŎƭǳŘƛƴƎ tǊƻŎŜǎǎƻǊΣ CŀƳƛƭȅΣ 5ŜǾƛŎŜΣ tŀŎƪŀƎŜΣ {ǇŜŜŘΣ ŀƴŘ /ƻƴŘƛǘƛƻƴΦ !ƭǎƻΣ ǎŜƭŜŎǘ wL{/π± {ƻ/ 
tǊƻƧŜŎǘ ƻǊ 9ƳǇǘȅ tǊƻƧŜŎǘ ƛƴ ǘƘŜ ¢ŜƳǇƭŀǘŜ 5ŜǎƛƎƴ ŦƛŜƭŘ όCƛƎǳǊŜ оΦмнύΦ 

 

Figure 3.12. Specify a Device for Template SoC Project  
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¶ hǊΣ ǘƻ ǎǇŜŎƛŦȅ ŀ ōƻŀǊŘ ŦƻǊ ŀ ƴŜǿ ¢ŜƳǇƭŀǘŜ {ƻ/ ǇǊƻƧŜŎǘΣ ŎƘŜŎƪ ǘƘŜ .ƻŀǊŘ ŎƘŜŎƪōƻȄ όCƛƎǳǊŜ оΦмоύΦ 

bƻǘŜΥ ̧ƻǳ Ŏŀƴ ŎƘƻƻǎŜ ±I5[κ±ŜǊƛƭƻƎ ƛƴ ǘƘŜ [ŀƴƎǳŀƎŜ ŦƛŜƭŘΦ  

 

Figure 3.13. Specify a Board for Template SoC Project 

2. CǊƻƳ ǘƘŜ .ƻŀǊŘ {ŜƭŜŎǘ ŀǊŜŀΣ ǎŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ōƻŀǊŘΣ ǎǳŎƘ ŀǎ ǘƘŜ aŀŎƘ·hо5ϰ .ǊŜŀƪƻǳǘ .ƻŀǊŘΦ 

3. 9ƴǘŜǊ ŀ ǇǊƻƧŜŎǘ ƴŀƳŜΦ  

Note: Do not include periods, colons, or spaces in the project name. 

4. όhǇǘƛƻƴŀƭύ ¢ƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴΣ ŎƭŜŀǊ ǘƘŜ ¦ǎŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ƻǇǘƛƻƴΣ ǘƘŜƴ ōǊƻǿǎŜ ŦƻǊ ŀƴƻǘƘŜǊ ƭƻŎŀǘƛƻƴΦ 
/ƘƻƻǎŜ ŀ ŦƛƭŜ ǎȅǎǘŜƳΦ 

5. {ŜƭŜŎǘ ŀ ŘŜǎƛǊŜŘ ǇƭŀǘŦƻǊƳ ǘŜƳǇƭŀǘŜ ŘŜǎƛƎƴΦ Lƴ ǇŀǊǘƛŎǳƭŀǊΣ ǎŜƭŜŎǘ 9ƳǇǘȅ tǊƻƧŜŎǘ ŦƻǊ ōǳƛƭŘƛƴƎ ǎȅǎǘŜƳ ŦǊƻƳ ǎŎǊŀǘŎƘΦ 

6. /ƭƛŎƪ CƛƴƛǎƘΦ 

The SoC design project is created in the workbench, and its design is opened and displayed in Lattice Propel Builder  
(Figure 3.16).  
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3.2.2. Opening an SoC Design in Lattice Propel Builder 

Within an SoC project, there is a Lattice Propel Builder design.  

To open Lattice Propel Builder for an SoC project: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀƴ {ƻ/ ǇǊƻƧŜŎǘΦ 

2. hǇŜƴ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ƛƴ ƻƴŜ ƻŦ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǿŀȅǎ ŦǊƻƳ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΥ  

¶ /ƘƻƻǎŜ [ŀǘǘƛŎŜ¢ƻƻƭǎ Ҕ  hǇŜƴ 5ŜǎƛƎƴ ƛƴ tǊƻǇŜƭ .ǳƛƭŘŜǊ όCƛƎǳǊŜ оΦмпύΦ 

 

Figure 3.14. LatticeTools Menu  

¶ /ƭƛŎƪ ǘƘŜ [ŀǘǘƛŎŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ ƛŎƻƴ  ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ  

¶ wƛƎƘǘπŎƭƛŎƪ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ŦǊƻƳ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊΦ /ƘƻƻǎŜ hǇŜƴ 5ŜǎƛƎƴ Lƴ Ҕ  tǊƻǇŜƭ .ǳƛƭŘŜǊ ŦǊƻƳ ǘƘŜ  
ǇƻǇπǳǇ ƳŜƴǳ όCƛƎǳǊŜ оΦмрύΦ  

  

Figure 3.15. Project Explorer Pop-up Menu 

3. ¢ƘŜ {ƻ/ 5ŜǎƛƎƴ ƛǎ ƻǇŜƴŜŘ ŀƴŘ ŘƛǎǇƭŀȅŜŘ ƛƴ [ŀǘǘƛŎŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ όCƛƎǳǊŜ оΦмсύΦ 

 

Figure 3.16. Lattice Propel Builder Window  
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4. όhǇǘƛƻƴŀƭύ aƻŘƛŦȅ ǘƘŜ ŘŜǎƛƎƴ ƛƴ [ŀǘǘƛŎŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ ŀǎ ŘŜǎƛǊŜŘΦ aƻǎǘ ƻŦ ǘƘŜ ǘŜƳǇƭŀǘŜǎ ƛƴŎƭǳŘŜ ŀ ŦǳƴŎǘƛƻƴŀƭπǊŜŀŘȅ 
{ƻ/ ŘŜǎƛƎƴΦ  

Note: You can only create an SoC design using the Empty Project template inside Lattice Propel Builder. Refer to  
Lattice Propel 2025.2 Builder User Guide (FPGA-UG-02243) for more details on how to create an SoC design using 
the Empty Project template.  

3.2.3. Opening a Design in Lattice FPGA Design Software 

Within an SoC project, you can create a Lattice FPGA design project including a Lattice Propel Builder design, and then 
open the FPGA design project in an appropriate software. There are two FPGA Design software available, the Lattice 
Diamond software and Lattice Radiantϰ software. Depending on the device family used in the SoC project, only one of 
the FPGA Design software can be selected from the User Interface (UI), and the other is grayed out. If the MachXO3D 
or Machϰ-NX device family is used, the Lattice Diamond software related menu items are active from the Lattice 
Propel UI. If the CrossLinkϰ-NX or Certusϰ-NX device family is used, the Lattice Radiant software related menu items 
are active from the Lattice Propel UI. 

To open FPGA Design Software for an SoC project from Lattice Propel SDK: 

1. όhǇǘƛƻƴŀƭύ {Ŝǘ [ŀǘǘƛŎŜ CtD! ŘŜǎƛƎƴ ǎƻŦǘǿŀǊŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƭƻŎŀǘƛƻƴ ŦǊƻƳ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΦ .ȅ ŘŜŦŀǳƭǘΣ [ŀǘǘƛŎŜ tǊƻǇŜƭ 
{5Y Ŏŀƴ ŦƛƴŘ ǘƘŜ ǇǊƻǇŜǊ [ŀǘǘƛŎŜ CtD! ŘŜǎƛƎƴ ǎƻŦǘǿŀǊŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƭƻŎŀǘƛƻƴΣ ǳǎǳŀƭƭȅ ǘƘŜ ƭŀǘŜǎǘ ǾŜǊǎƛƻƴ ƛƴǎǘŀƭƭŜŘ ƻƴ 
ǘƘŜ t/Φ ¸ƻǳ Ŏŀƴ ƻǾŜǊǿǊƛǘŜ ƛǘ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎ ōŜƭƻǿΦ    

Choose Window > Preferences. The Preferences dialog opens (Figure 3.17). 

Select Propel Setting from the left pane. Click the Browse button to pick up the installation location of the Lattice 
Diamond software or Lattice Radiant software. Or, leave the Radiant Location and Diamond Location fields blank, 
as default. Lattice Propel SDK can find the location automatically. 

 

Figure 3.17. Lattice Propel Preferences Dialog 

2. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿ ŦǊƻƳ ǘƘŜ [ŀǘǘƛŎŜ tǊƻǇŜƭ Ƴŀƛƴ DǊŀǇƘƛŎŀƭ ¦ǎŜǊ LƴǘŜǊŦŀŎŜ όD¦LύΣ ǎŜƭŜŎǘ ŀƴ {ƻ/ ǇǊƻƧŜŎǘΦ  

3. hǇŜƴ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ƛƴ ƻƴŜ ƻŦ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǿŀȅǎΥ  
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¶ /ƘƻƻǎŜ [ŀǘǘƛŎŜ¢ƻƻƭǎ Ҕ DŜƴŜǊŀǘŜ ŀƴŘ hǇŜƴ 5ƛŀƳƻƴŘ tǊƻƧŜŎǘΦ hǊΣ ŎƘƻƻǎŜ [ŀǘǘƛŎŜ¢ƻƻƭǎ Ҕ DŜƴŜǊŀǘŜ 
ŀƴŘ hǇŜƴ wŀŘƛŀƴǘ tǊƻƧŜŎǘΦ 

¶ /ƭƛŎƪ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ǎƻŦǘǿŀǊŜ ƛŎƻƴ  ƻǊ ǘƘŜ [ŀǘǘƛŎŜ wŀŘƛŀƴǘ ǎƻŦǘǿŀǊŜ ƛŎƻƴ ŦǊƻƳ ǘƘŜ ǘƻƻƭōŀǊΦ 

¶ wƛƎƘǘπŎƭƛŎƪ ŀƴ {ƻ/ ǇǊƻƧŜŎǘ ŦǊƻƳ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊΦ /ƘƻƻǎŜ hǇŜƴ 5ŜǎƛƎƴ Lƴ Ҕ 5ƛŀƳƻƴŘΦ hǊΣ ŎƘƻƻǎŜ 
hǇŜƴ 5ŜǎƛƎƴ Lƴ Ҕ        wŀŘƛŀƴǘ ŦǊƻƳ ǘƘŜ ǊƛƎƘǘπŎƭƛŎƪ ƳŜƴǳΦ  

4. ¢ƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ƻǊ wŀŘƛŀƴǘ ǇǊƻƧŜŎǘ ŦƻǊ {ƻ/ ƛǎ ƎŜƴŜǊŀǘŜŘ ŀǘ ōŀŎƪƎǊƻǳƴŘ ŀƴŘ ƛǎ ƭŀǳƴŎƘŜŘ όCƛƎǳǊŜ оΦмуκ 
CƛƎǳǊŜ оΦмфύΦ 

 

Figure 3.18. Lattice Diamond Software Project 
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Figure 3.19. Lattice Radiant Software Project 

5. όhǇǘƛƻƴŀƭύ CǊƻƳ ǘƘŜ CƛƭŜ [ƛǎǘ ǾƛŜǿ ƻŦ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ƻǊ wŀŘƛŀƴǘ ǎƻŦǘǿŀǊŜΥ 

¶ ƳƻŘƛŦȅ ǘƘŜ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ όғǇǊƻƧψƴŀƳŜҔψ¢ƻǇΦǾύ ǘƻ ƳŀǘŎƘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΣ ǇǊŜǎǳǇǇƻǎƛǘƛƻƴ ƻŦ ǿƘƛŎƘ ƛǎ 
ǘƘŀǘ ǘƘŜǊŜ ƛǎ ŀ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ ƛƴ ȅƻǳǊ {ƻ/ ŘŜǎƛƎƴΤ ƻǊ 

¶ ŎǊŜŀǘŜ ŀ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ όғǇǊƻƧψƴŀƳŜҔψ¢ƻǇΦǾύ ǘƻ ƳŀǘŎƘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΣ ƛŦ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ƛǎ ŎǊŜŀǘŜŘ ŦǊƻƳ 
ŀƴ 9ƳǇǘȅ tǊƻƧŜŎǘ ǘŜƳǇƭŀǘŜ ŀƴŘ ǘƘŜǊŜ ƛǎ ƴƻ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ ƛƴ ȅƻǳǊ {ƻ/ ŘŜǎƛƎƴΦ  

6.  όhǇǘƛƻƴŀƭύ aƻŘƛŦȅ ŎƻƴǎǘǊŀƛƴǘ ŦƛƭŜ όғǇǊƻƧψƴŀƳŜҔΦƭǇŦκғǇǊƻƧψƴŀƳŜҔΦǇŘŎύ ǘƻ ƳŀǘŎƘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΣ ƛŦ ȅƻǳ ƘŀǾŜ 
ƳƻŘƛŦƛŜŘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΦ  

bƻǘŜΥ ¢Ƙƛǎ ǎǘŜǇ ƛǎ ŀ Ƴǳǎǘ ŦƻǊ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ŎǊŜŀǘŜŘ ŦǊƻƳ ǘƘŜ 9ƳǇǘȅ tǊƻƧŜŎǘ ǘŜƳǇƭŀǘŜΦ 

7. tǊƻŎŜǎǎ ǘƘŜ ŘŜǎƛƎƴ ƛƴ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ƻǊ wŀŘƛŀƴǘ ǎƻŦǘǿŀǊŜΦ 

Lƴ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ǎƻŦǘǿŀǊŜΣ ǎǿƛǘŎƘ ǘƻ ǘƘŜ tǊƻŎŜǎǎ ǾƛŜǿ ƻŦ ǘƘŜ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ оΦнлύΦ aŀƪŜ ǎǳǊŜ ŀǘ ƭŜŀǎǘ ƻƴŜ ŦƛƭŜΣ 
L.L{ aƻŘŜƭΣ ±ŜǊƛƭƻƎ {ƛƳǳƭŀǘƛƻƴ CƛƭŜΣ ±I5[ {ƛƳǳƭŀǘƛƻƴ CƛƭŜΣ .ƛǘǎǘǊŜŀƳ CƛƭŜΣ ƻǊ W959/ ŦƛƭŜΣ ƛǎ ŎƘŜŎƪŜŘ ƛƴ ǘƘŜ 9ȄǇƻǊǘ CƛƭŜǎ 

ǎŜŎǘƛƻƴ ŦƻǊ ǇǊƻƎǊŀƳƳƛƴƎΦ /ƘƻƻǎŜ tǊƻŎŜǎǎ Ҕ  wǳƴΦ   
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Figure 3.20. Generate Programming File in Lattice Diamond Software 

In Lattice Radiant software, from the Process Toolbar, click Export Files (Figure 3.21). 

 

Figure 3.21. Generate Programming File in Lattice Radiant Software 

The Programming file is generated. The programming file can be used in Programmer. 

Note: Programmer is a tool that can program Lattice FPGA SRAM and external SPI Flash through various interfaces, 

such as JTAG, SPI, and I2C.  
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3.2.4. Generating System Environment by Building Project 

System environment package including the system environment file and the BSP package is required for the embedded 
C/C++ project. 

To generate system environment package from Lattice Propel SDK:  

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀƴ {ƻ/ ǇǊƻƧŜŎǘΦ 

2. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ 

3. /ƘŜŎƪ ǘƘŜ ōǳƛƭŘƛƴƎ ǊŜǎǳƭǘ ƛƴ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿ όCƛƎǳǊŜ оΦннύΦ 

 

Figure 3.22. Build Result of SoC Project 

3.2.5. About SoC Design Project 

The SoC project creating starts with a functional-ready SoC design and a default simulation environment. In the Project 
Explorer view, open an SoC project folder and all its sub-folders. The project contains but is not limited to the following 
files (Figure 3.23), some of which may vary upon opening the SoC design project in the Lattice Diamond or Radiant 
software: 

¶ <proj_name>: folder containing a Lattice Propel Builder design including the .sbx file. 

¶ <proj_name>/application: folder containing functional-ready embedded application source codes.  

¶ impl1: folder containing the implementation of the Lattice Diamond or Radiant project. 

¶ sge: folder containing generated package necessary for creating a C/C++ project.  

¶ verification: folder containing the SoC verification project. 

¶ verification/sim: folder containing the simulation environment. 

¶ <proj_name>.ldf: Lattice Diamond project file. 

¶ <proj_name>.lpf: Lattice Diamond project logical preference file. 

¶ <proj_name>.rdf: Lattice Radiant project file. 

¶ <proj_name>.pdc: Lattice Radiant project post-synthesis constraints. 

¶ <proj_name>.txt: description file from the template.  
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Figure 3.23. Contents of SoC Project 

3.3. C/C++ Project Design Flow 

3.3.1. Creating a Lattice C/C++ Project 

To start a Lattice C/C++ Project from Lattice Propel SDK: 

1. /ƘƻƻǎŜ CƛƭŜ Ҕ bŜǿ Ҕ  [ŀǘǘƛŎŜ /κ/ҌҌ tǊƻƧŜŎǘΦ  

¢ƘŜ /κ/ҌҌ tǊƻƧŜŎǘ ǿƛȊŀǊŘ ƻǇŜƴǎ ǿƛǘƘ ǘƘŜ [ƻŀŘ {ȅǎǘŜƳ ŀƴŘ .{t ǇŀƎŜ όCƛƎǳǊŜ оΦнпύΦ 
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Figure 3.24. Load System and BSP Page 1 

2. .ǊƻǿǎŜ ǘƻ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ŦƻƭŘŜǊ ŀƴŘ ǎŜƭŜŎǘ ǘƘŜ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ŦƛƭŜ ǎȅǎψŜƴǾΦȄƳƭΦ  

!ƭƭ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ŦƛƭŜǎ ŀǾŀƛƭŀōƭŜ ƛƴ ǘƘŜ ŎǳǊǊŜƴǘ ǿƻǊƪǎǇŀŎŜ Ŏŀƴ ōŜ ǎŜƭŜŎǘŜŘ ŦǊƻƳ ǘƘŜ {ȅǎǘŜƳ ŜƴǾ ŘǊƻǇπŘƻǿƴ 
ƳŜƴǳΦ LŦ ȅƻǳ ǎŜƭŜŎǘ ƻǊ ŜƴǘŜǊ v9a¦ wL{/π± ±ƛǊǘǳŀƭ {ƻ/ {ȅǎǘŜƳΣ ȅƻǳ Ŏŀƴ ǎŜƭŜŎǘ ǘƘŜ v9a¦ ŀǇǇƭƛŎŀǘƛƻƴ ǘŜƳǇƭŀǘŜ ǘƻ 
ŎǊŜŀǘŜ ŀ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ оΦнрύΦ 
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Figure 3.25. Load System and BSP Page 2 

3. LŦ ǘƘŜ ǇƭŀǘŦƻǊƳ Ƙŀǎ ƳƻǊŜ ǘƘŀƴ ƻƴŜ ǇǊƻŎŜǎǎƻǊΣ ŎƘƻƻǎŜ ƻƴŜ ŎƻǊŜΦ 

4. {ŜƭŜŎǘ ǘƘŜ ǇǊƻƧŜŎǘ ǘȅǇŜΣ / ƻǊ /ҌҌΦ 

5. {ŜƭŜŎǘ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ŦǊƻƳ ǘƘŜ 9ȄŀƳǇƭŜ ŀǇǇƭƛŎŀǘƛƻƴ ƭƛǎǘΦ 

6. ¢ƘŜǊŜ ƛǎ ŀ ŘŜŦŀǳƭǘ ǇǊƻƧŜŎǘ ƴŀƳŜΦ ̧ƻǳ ƴŜŜŘ ǘƻ ŎƘŜŎƪ ƛǘΦ {ǳƎƎŜǎǘ ƴƻǘ ǳǎƛƴƎ ǇŜǊƛƻŘǎΣ ŎƻƭƻƴǎΣ ƻǊ ǎǇŀŎŜǎ ƛƴ ȅƻǳǊ ǇǊƻƧŜŎǘ 
ƴŀƳŜΦ ¢ƘƻǳƎƘ ǎǇŀŎŜ ƛǎ ŀƭƭƻǿŜŘΣ ǘƘŜȅ Ƴŀȅ ŎŀǳǎŜ ŎŜǊǘŀƛƴ ƛǎǎǳŜǎ ǿƛǘƘ ǎƻƳŜ ǘƻƻƭǎΦ  

7. .ȅ ŘŜŦŀǳƭǘΣ ǘƘŜ ¦ǎŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ƻǇǘƛƻƴ ƛǎ ŎƘŜŎƪŜŘΦ ¢ƘŜ ŘŜŦŀǳƭǘ ŦƛƭŜ ǎȅǎǘŜƳ ƛǎ ǎŜƭŜŎǘŜŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅΦ {ǳƎƎŜǎǘ 
ǳǎƛƴƎ ǘƘŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ǳƴƭŜǎǎ ȅƻǳ ƘŀǾŜ ǎǇŜŎƛŀƭ ƴŜŜŘ ǘƻ ŀ ǎǇŜŎƛŀƭ ƭƻŎŀǘƛƻƴΦ 

8. ¢ƘŜ .ǳƛƭŘ ǘƘŜ ǇǊƻƧŜŎǘ ƻǇǘƛƻƴ ƛǎ ǳƴŎƘŜŎƪŜŘ ōȅ ŘŜŦŀǳƭǘΦ LŦ ȅƻǳ ǿŀƴǘ ǘƻ ōǳƛƭŘ ǘƘŜ ǇǊƻƧŜŎǘ ŀǳǘƻƳŀǘƛŎŀƭƭȅΣ ȅƻǳ Ŏŀƴ ŎƘŜŎƪ 
ǘƘŜ ƻǇǘƛƻƴΦ 

9. .ȅ ŘŜŦŀǳƭǘΣ ǘƘŜ /ǊŜŀǘŜ ŀ ŘŜōǳƎ ƭŀǳƴŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ŦƻǊ ƻǇǘƛƻƴ ƛǎ ŎƘŜŎƪŜŘ ŀƴŘ ŀ ŘŜŦŀǳƭǘ ƭŀǳƴŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƛǎ 
ŎǊŜŀǘŜŘ ŀŎŎƻǊŘƛƴƎƭȅΦ 

10. /ƭƛŎƪ bŜȄǘΦ ¢ƘŜ [ŀǘǘƛŎŜ ¢ƻƻƭŎƘŀƛƴ {ŜǘǘƛƴƎ ŘƛŀƭƻƎ ƻǇŜƴǎ όCƛƎǳǊŜ оΦнсύΦ 
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Figure 3.26. Lattice Toolchain Setting Dialog 1 

11. .ȅ ŘŜŦŀǳƭǘΣ ǘǿƻ ǘƻƻƭŎƘŀƛƴ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƳƻŘŜǎΣ 5ŜōǳƎ ŀƴŘ wŜƭŜŀǎŜΣ Ŏŀƴ ōŜ ŎƘƻǎŜƴ ŦǊƻƳ ǘƘŜ /ƻƴŦƛƎǳǊŀǘƛƻƴ 
ŘǊƻǇπŘƻǿƴ ƳŜƴǳΦ  

¶ 5ŜōǳƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ŎǊŜŀǘŜǎ ŜȄŜŎǳǘŀōƭŜǎ ŎƻƴǘŀƛƴƛƴƎ ŀŘŘƛǘƛƻƴŀƭ ŘŜōǳƎ ƛƴŦƻǊƳŀǘƛƻƴ ǘƘŀǘ ƭŜǘǎ ǘƘŜ ŘŜōǳƎƎŜǊ 
ƳŀƪŜ ŘƛǊŜŎǘ ŀǎǎƻŎƛŀǘƛƻƴǎ ōŜǘǿŜŜƴ ǘƘŜ ǎƻǳǊŎŜ ŎƻŘŜ ŀƴŘ ǘƘŜ ōƛƴŀǊȅ ŦƛƭŜǎ ƎŜƴŜǊŀǘŜŘ ŦǊƻƳ ǘƘŜ ƻǊƛƎƛƴŀƭ ǎƻǳǊŎŜΦ  

¶ wŜƭŜŀǎŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǇǊƻǾƛŘŜǎ ǘƘŜ ǘƻƻƭǎ ǿƛǘƘ ƻǇǘƛƻƴǎ ǎŜǘǘƛƴƎ ǘƻ ŎǊŜŀǘŜ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛǘƘ ǘƘŜ ōŜǎǘ 
ǇŜǊŦƻǊƳŀƴŎŜΦ 

¸ƻǳ Ŏŀƴ ƳƻŘƛŦȅ ŦǊŜǉǳŜƴǘƭȅπǳǎŜŘ ƭƛōǊŀǊȅΣ ŎƻƳǇƛƭŜǊΣ ŀƴŘ ƭƛƴƪŜǊ ƻǇǘƛƻƴǎ ŦƻǊ ŜŀŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ CƻǊ ŀ ŎƻƳǇƭŜǘŜ 
ǘƻƻƭŎƘŀƛƴ ǎŜǘǘƛƴƎΣ Ǝƻ ǘƻ ǇǊƻƧŜŎǘ ǇǊƻǇŜǊǘƛŜǎ ŀŦǘŜǊ ŎǊŜŀǘƛƴƎ ǘƘŜ ǇǊƻƧŜŎǘΦ wŜŦŜǊ ǘƻ ǘƘŜ !ŘǾŀƴŎŜŘ ¢ƻƻƭ /Ƙŀƛƴ {ŜǘǘƛƴƎ 
ǎŜŎǘƛƻƴΦ 

¶ Lƴ ǘƘŜ [ƛō {ŜǘǘƛƴƎ ǘŀōΣ ǎǘŀƴŘŀǊŘ / ƭƛōǊŀǊȅ Ŏŀƴ ōŜ ǊŜŎƻƴŦƛƎǳǊŜŘΦ tƛŎƻƭƛōŎ ό/ [ƛōǊŀǊƛŜǎ ŦƻǊ {ƳŀƭƭŜǊ 9ƳōŜŘŘŜŘ 
{ȅǎǘŜƳǎύ ƛǎ ǎŜƭŜŎǘŜŘ ōȅ ŘŜŦŀǳƭǘ ŀƴŘ ƛǘ ǎǳǇǇƻǊǘǎ ŘƛŦŦŜǊŜƴǘ ǇǊƛƴǘŦ ƭŜǾŜƭǎΦ 

¶ Lƴ ǘƘŜ /κ/ҌҌ /ƻƳǇƛƭŜǊ ǘŀōΣ ƻǇǘƛƳƛȊŀǘƛƻƴ ƭŜǾŜƭ ŀƴŘ ŘŜōǳƎ ƭŜǾŜƭ Ŏŀƴ ōŜ ǊŜŎƻƴŦƛƎǳǊŜŘ ŦƻǊ ŜŀŎƘ ǘƻƻƭŎƘŀƛƴ 
ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ  

¶ Lƴ ǘƘŜ /κ/ҌҌ [ƛƴƪŜǊ ǘŀōΣ wŜƳƻǾŜ ǳƴǳǎŜŘ ŎƻŘŜ όππƎŎπǎŜŎǘƛƻƴǎύ ƛǎ ŎƘŜŎƪŜŘ ōȅ ŘŜŦŀǳƭǘ ŦƻǊ ƎŀǊōŀƎŜ ŎƻƭƭŜŎǘƛƻƴ 
ƻŦ ǳƴǳǎŜŘ ŎƻŘŜΦ 

12. /ƭƛŎƪ CƛƴƛǎƘΦ 

¢ƘŜ [ŀǘǘƛŎŜ /κ/ҌҌ ǇǊƻƧŜŎǘ ƛǎ ŎǊŜŀǘŜŘ ŀƴŘ ƛǎ ŘƛǎǇƭŀȅŜŘ ǳǎƛƴƎ ǘƘŜ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5Y ǇŜǊǎǇŜŎǘƛǾŜΦ ! ǇŜǊǎǇŜŎǘƛǾŜ ƛǎ ŀ 
ŎƻƭƭŜŎǘƛƻƴ ƻŦ ǘƻƻƭ ǾƛŜǿǎ ŦƻǊ ŀ ǇŀǊǘƛŎǳƭŀǊ ǇǳǊǇƻǎŜΦ ¢ƘŜ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5Y ǇŜǊǎǇŜŎǘƛǾŜ ƛǎ ŦƻǊ ŎǊŜŀǘƛƴƎ [ŀǘǘƛŎŜ /κ/ҌҌ 
ǇǊƻƎǊŀƳǎΦ 
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3.3.2. Updating a Lattice C/C++ Project 

When you make changes to an SoC project, sometimes you want to synchronize the changes to an existing Lattice 
C/C++ project instead of creating a new Lattice C/C++ project. In this case, you can use the update C/C++ project 
feature. 

Note: This feature overwrites the corresponding files or settings of your existing C/C++ project. Be sure to back up your 
C/C++ project before using this feature.  

To update a Lattice C/C++ Project from Lattice Propel SDK: 

1. DŜƴŜǊŀǘŜ ǘƘŜ ƭŀǘŜǎǘ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ǇŀŎƪŀƎŜ ŀŎŎƻǊŘƛƴƎ ǘƻ ǘƘŜ DŜƴŜǊŀǘƛƴƎ {ȅǎǘŜƳ 9ƴǾƛǊƻƴƳŜƴǘ ōȅ .ǳƛƭŘƛƴƎ 
tǊƻƧŜŎǘ ǎŜŎǘƛƻƴΦ  

2. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

3. Choose Project > Update Lattice C/C++ tǊƻƧŜŎǘΧ. 

The C/C++ Project wizard opens for updating system and BSP (Figure 3.27). 

 

Figure 3.27. Update System and BSP Dialog 

4. Browse to the SoC project folder and select the system environment file sys_env.xml.  

5. Select the checkbox for what you can update: 

¶ wŜπƎŜƴŜǊŀǘŜ ǘƻƻƭŎƘŀƛƴ ǇŀǊŀƳŜǘŜǊǎ ŀƴŘ ƭƛƴƪŜǊ ǎŎǊƛǇǘΥ ŎƘŜŎƪ ǘƘƛǎ ƻǇǘƛƻƴ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ƳƻŘƛŦȅ /t¦ ƻǊ 
ƳŜƳƻǊȅ ƛƴ ǘƘŜ ǎȅǎǘŜƳΦ 

¶ ¦ǇŘŀǘŜ .{t ǇŀŎƪŀƎŜΥ ŎƘŜŎƪ ǘƘƛǎ ƻǇǘƛƻƴ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ŀŘŘ ŀŘŘƛǘƛƻƴŀƭ Lt ŎƻƳǇƻƴŜƴǘǎ ƛƴǘƻ ǘƘŜ ǎȅǎǘŜƳΦ  

6. Click Update to make changes for the selected C/C++ project. 

7. Click Yes (Figure 3.28). 
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Figure 3.28. Update System and BSP Confirm Dialog 

3.3.3. Building a Lattice C/C++ Project 

To build a Lattice C/C++ project in Lattice Propel SDK: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

2. Cƻƭƭƻǿ ǎǘŜǇǎ ōŜƭƻǿ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŀŎǘƛǾŜ ōǳƛƭŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴΥ 

a. Choose tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ /ƻƴŦƛƎǳǊŀǘƛƻƴǎ Ҕ aŀƴŀƎŜΧ. Or, click the Configuration icon  on the toolbar. 

b. The Manage Configurations dialog opens (Figure 3.29) for choosing active configuration. By default, a Debug 
configuration creates executables containing additional debug information that lets the debugger make direct 
associations between the source code and the binary files generated from the original source. A Release 
configuration provides the tools with options setting to create an application with the best performance. 

 

Figure 3.29. Manage Configurations Dialog 

3. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ hǊΣ ŎƭƛŎƪ ǘƘŜ .ǳƛƭŘ ƛŎƻƴ    ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ 

4. ¢ƘŜ ǊŜǎǳƭǘǎ ƻŦ ǘƘŜ ōǳƛƭŘ ŎƻƳƳŀƴŘ ŀǊŜ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿ όCƛƎǳǊŜ оΦолύΦ 

 

Figure 3.30. Build Result of C/C++ Project 
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3.3.4. About Lattice C/C++ Project 

The Lattice C/C++ project starts with source code. In the Project Explorer view, open a C/C++ project folder and all its 
sub-folders. The project contains: 

¶ src/bsp/driver: folder containing driver codes from the IP in the platform. 

¶ src/bsp/sys_platform.h: header file that defines DEVICE_FAMILY (the Lattice FPGA), address mapping, and any IP 
parameters that can be used by the drivers. 

¶ src/main.c: source file containing the main routine, which is the entry-point of a C/C++ program.  

¶ src/cpu.svd: system view description file used for peripherals registers view at debug perspective. 

¶ src/cpu.yaml: processor description file used when debugging. 

¶ src/linker.ld: linker script file. 

¶ src/sys_env.xml: system environment file describing aspects of the platform, such as memory spaces. 

After building the project, the build output can be found in each build configuration folder, the Debug folder or the 
Release folder (Figure 3.31). The Debug or Release folder contains: 

¶ <proj_name>.elf: executable file used in on-chip debugging. 

¶ <proj_name>.bin: binary file used in deploying the application to flash memory. 

¶ <proj_name>.lst: extended listing file generated by tool objdump.  

¶ <proj_name>.map: linker map file. 

¶ <proj_name>.mem: Lattice system memory initialization file used in the System Memory IP. 

¶ <proj_name>.launch: Debug launch configuration. 

Note: Some of the files listed in Figure 3.31 are intermediate files that you do not need to take care of. 
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Figure 3.31. Contents of C/C++ Project 

3.3.5. Assisting in Developing Code 

Lattice Propel SDK is based on Eclipse IDE. You can write application code following the process and usage of the same 
tools as any in Eclipse IDE. You can get more detailed information regarding Eclipse IDE from the Lattice Propel online 
help.  

For writing code, Lattice Propel SDK provides two extra aids: 

¶ Lattice System Platform: An overview of the processor platform can be displayed (Figure 3.32). 

¶ Linker Editor: An overview of the memory regions of linker script can be displayed. You can modify key linker 
parameters through the graphical interface (Figure 3.33). 
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Figure 3.32. Lattice System Platform 

 

Figure 3.33. Linker Editor 

3.3.6. Advanced Tool Chain Setting 

Follow the process below to modify the tool chain settings of a C/C++ project. 

To change tool chain setting in Project Properties in Lattice Propel SDK: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿ ƻŦ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

2. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ tǊƻǇŜǊǘƛŜǎΦ ¢ƘŜ tǊƻǇŜǊǘƛŜǎ ŦƻǊ ǘƘŜ ŎǳǊǊŜƴǘ ǇǊƻƧŜŎǘ ƻǇŜƴǎ όCƛƎǳǊŜ оΦопύΦ 
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3. {ŜƭŜŎǘ {ŜǘǘƛƴƎǎ ƻŦ ǘƘŜ /κ/ҌҌ .ǳƛƭŘ ŎŀǘŜƎƻǊȅ ŦǊƻƳ ǘƘŜ ƭŜŦǘ ǇŀƴŜΦ {ŜƭŜŎǘ ǘƘŜ ¢ƻƻƭ {ŜǘǘƛƴƎǎ ǘŀōΦ 

 

Figure 3.34. Properties of C/C++ Project 

4. /ǳǎǘƻƳƛȊŜ ǘƘŜ ǘƻƻƭǎ ŀƴŘ ǘƻƻƭ ƻǇǘƛƻƴǎΦ !ƭƭ ȅƻǳǊ ŎǳǎǘƻƳƛȊŀǘƛƻƴ Ŏŀƴ ōŜ ƳŀŘŜ ƛƴ ǘƘŜ ōǳƛƭŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƛƴ ǘƘŜ ¢ƻƻƭ 
{ŜǘǘƛƴƎǎ ǇǊƻǇŜǊǘƛŜǎ ǘŀōΦ ¢ƘŜ ōǳƛƭŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƛǎ ǳǎŜŘ ŘǳǊƛƴƎ ȅƻǳǊ /κ/ҌҌ ǇǊƻƧŜŎǘ ōǳƛƭŘƛƴƎΦ  

Note: The setting for each configuration, Debug or Release, is independent. 

5. /ƭƛŎƪ !ǇǇƭȅ ŀƴŘ /ƭƻǎŜ ǘƻ ǎŀǾŜ ǘƘŜ ŎƘŀƴƎŜΦ 

Note: You may need to clean the project to make the new settings take effect for the whole project.  

3.4. System Simulation Flow 
The SoC Project created from template has a default simulation environment for you to set up and start functional 
simulation. It is generated automatically along with the SoC project creation. You can use it as a start point and 
customize accordingly. 
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The default simulation environment is with the following features: 

¶ Provides similar user experience as real board-level debugging, such as for Hello World SoC, key components 
including RISC-V MC, System Memory, and UART. 

¶ Simulates user-modified template SoC with extended HDL designs. 

¶ Simulates the whole system using real C/C++ projects as stimulus with the necessary modification and with all the 
details for debugging. 

¶ Supports user extension with a friendly and flexible approach. 

3.4.1. Launching Simulation 

To launch simulation: 

1. Lƴ [ŀǘǘƛŎŜ tǊƻǇŜƭ .ǳƛƭŘŜǊΣ ǳǇŘŀǘŜ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ǘƻ ŜƴŀōƭŜ ǎƛƳǳƭŀǘƛƻƴ ŦŜŀǘǳǊŜǎΦ 

Enable the checkbox for Initialize Memory for the System Memory module from the Initialization area of the 
General tab. Then, set the Initialization File generated from the corresponding C/C++ project (Figure 3.35). 

 

Figure 3.35. Configuring System Memory Module 1 

2. /ƭƛŎƪ ǘƘŜ {ǿƛǘŎƘ ƛŎƻƴ ƻƴ ǘƘŜ ǘƻƻƭōŀǊ ǘƻ ǎǿƛǘŎƘ ōŜǘǿŜŜƴ {ƻ/ ŘŜǎƛƎƴ ŀƴŘ {ƻ/ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ оΦосύΦ 

3. !ŦǘŜǊ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ƛǎ ǎǿƛǘŎƘŜŘ ǘƻ ŀƴ {ƻ/ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘΣ ŎƭƛŎƪ ǘƘŜ DŜƴŜǊŀǘŜ ƛŎƻƴ  ǘƻ ƎŜƴŜǊŀǘŜ ǘƘŜ 

ǎƛƳǳƭŀǘƛƻƴ ŜƴǾƛǊƻƴƳŜƴǘΦ /ƭƛŎƪ ǘƘŜ [ŀǳƴŎƘ {ƛƳǳƭŀǘƛƻƴ ƛŎƻƴ  όCƛƎǳǊŜ оΦосύΦ 
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Figure 3.36. SoC Verification Project 

4. vǳŜǎǘŀ{ƛƳ ƛǎ ƭŀǳƴŎƘŜŘ ǊǳƴƴƛƴƎ ǎƛƳǳƭŀǘƛƻƴ ŦƻǊ ǘƘŜ {ƻ/ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘΦ ¢ƘŜ ŎƻǊǊŜǎǇƻƴŘƛƴƎ ǿŀǾŜŦƻǊƳ ƻŦ ǘƘŜ {ƻ/ 
ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘ ŦƻǊ ǘƘŜ IŜƭƭƻ ²ƻǊƭŘ ǇǊƻƧŜŎǘ ƛǎ ǎƘƻǿƴ όCƛƎǳǊŜ оΦотύΦ /ƘŜŎƪ ǘƘŜ ǿŀǾŜŦƻǊƳΦ  

 

Figure 3.37. Questa Simulation GUI  
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3.4.2. Simulation Details 

The default simulation environment is located at the generated sim folder inside the SoC verification project in Lattice 
Propel SDK. It contains: 

 

You can extend more verification features in the top testbench. 

3.5. Programming and On-Chip Debugging Flow  
This section describes the process of testing and debugging application code on the actual hardware including the 
Lattice FPGA with the hardware design installed. Debugging with Lattice Propel SDK follows the same process and uses 
of the same tools in Eclipse IDE. 

Before debugging, download the hardware design created from the Lattice Diamond or Radiant Programmer. Refer to 
the User Guide of the specific evaluation board for more details on the evaluation board. 

3.5.1. Creating a Debug Launch Configuration 

To debug a program, a debug launch configuration must be created. Most of the settings for a debug launch 
configuration can be automatically entered. Only a few settings need to be manually configured. 

To create a debug launch configuration: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿ ƻŦ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

2. .ǳƛƭŘ ǘƘŜ ǇǊƻƧŜŎǘ ŀƴŘ ŜƴǎǳǊŜ ǘƘŜ ŜȄŜŎǳǘŀōƭŜ ŦƛƭŜ ƛǎ ŀǾŀƛƭŀōƭŜΦ wŜŦŜǊ ǘƻ ǘƘŜ .ǳƛƭŘƛƴƎ ŀ [ŀǘǘƛŎŜ /κ/ҌҌ tǊƻƧŜŎǘ ǎŜŎǘƛƻƴ ŦƻǊ 
ŘŜǘŀƛƭǎ ƻƴ ǘƘŜ ǇǊƻŎŜǎǎΦ 

3. /ƘƻƻǎŜ wǳƴ Ҕ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧΦ 

¢ƘŜ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎ ŘƛŀƭƻƎ ƻǇŜƴǎ όCƛƎǳǊŜ оΦофύΦ 

+---  [ sim]                      --  Generated simulation environment  folder  

|   + ---  [hdl_header]  

|   |   + ---  soc_regs.v        --  Register definitions of all the components in DUT/SOC  

|   |   + ---  sys_platform.v    --  Base address, user settings of all the components in DUT/SOC  

|   + ---  [misc]  

|   |  +---  *.*               --  All the mem, hex, txt files are  copied here  

|   + ---  flist.f               --  File list for HDLs  

|   + ---  flist _sim.f           --  File list for all files used in simulation  

|   + ---  qsim.do                --  Do script for simulator,  

 qsim.do : QuestaSim. |                                  

 This file compiles project and invokes simulator with  

|                                 some default settings using the generated testbench.  

|   + ---  wave.do               --  Do script for adding signals in waveform window  

|   + ---  <project_name> _v.sv   --  Top testbench, it  i s SystemVerilog  based.  
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Figure 3.38. Debug Configurations Dialog 1 

4. 5ƻǳōƭŜπŎƭƛŎƪ D5. hǇŜƴh/5 5ŜōǳƎƎƛƴƎ ǘƻ ŎǊŜŀǘŜ ŀ ƴŜǿ ƭŀǳƴŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ 

! Ƴǳƭǘƛπǘŀō ǇŀƎŜ ƛǎ ŘƛǎǇƭŀȅŜŘΦ ¢ƘŜ aŀƛƴ ǘŀō ǎƘƻǳƭŘ ŀƭǊŜŀŘȅ ōŜ ŦƛƭƭŜŘ ƛƴ ǿƛǘƘ ǘƘŜ ǇǊƻƧŜŎǘ ƴŀƳŜΣ ŀǇǇƭƛŎŀǘƛƻƴ ŦƛƭŜ ƴŀƳŜΣ 
ŀƴŘ ƭƻŎŀǘƛƻƴΦ 

5. {ŜƭŜŎǘ ǘƘŜ /ŀōƭŜ/ƻƴƴ ǘŀō όCƛƎǳǊŜ оΦофύΦ ¢Ƙƛǎ ǘŀō ŜƴŀōƭŜǎ ȅƻǳ ǘƻ ǎŜƭŜŎǘ ŀ ǎǇŜŎƛŦƛŎ ŘŜǾƛŎŜ ƻƴ ŀ ǎǇŜŎƛŦƛŎ ŎŀōƭŜ ǇƻǊǘΦ 

/ƭƛŎƪ ǘƘŜ 5ŜǘŜŎǘ /ŀōƭŜ ōǳǘǘƻƴΦ {ŜƭŜŎǘ ǘƘŜ ǎǇŜŎƛŦƛŎ ŎŀōƭŜ ǇƻǊǘ ŦǊƻƳ ǘƘŜ tƻǊǘ ŘǊƻǇπŘƻǿƴ ƭƛǎǘΦ .ȅ ŘŜŦŀǳƭǘΣ ǘƘŜ ŦƛǊǎǘ 
ŀǾŀƛƭŀōƭŜ ŎŀōƭŜ ǇƻǊǘΥ C¢¦{.πл ƛǎ ǎŜƭŜŎǘŜŘΦ 

/ƭƛŎƪ ǘƘŜ {Ŏŀƴ 5ŜǾƛŎŜ ōǳǘǘƻƴΦ {ŜƭŜŎǘ ǘƘŜ ǎǇŜŎƛŦƛŎ ŘŜǾƛŎŜ ŦǊƻƳ ǘƘŜ 5ŜǾƛŎŜ ŘǊƻǇπŘƻǿƴ ƭƛǎǘΦ .ȅ ŘŜŦŀǳƭǘΣ ǘƘŜ ŦƛǊǎǘ 
ŀǾŀƛƭŀōƭŜ ŘŜǾƛŎŜ ƻƴ ǘƘŜ ǎŜƭŜŎǘŜŘ ŎŀōƭŜ ǇƻǊǘ ƛǎ ǎŜƭŜŎǘŜŘΦ 

{ŜƭŜŎǘ ǘƘŜ W¢!D ŎƘŀƴƴŜƭ ƴǳƳōŜǊ ŦǊƻƳ ǘƘŜ /ƘŀƴƴŜƭ ŘǊƻǇπŘƻǿƴ ƭƛǎǘΦ .ȅ ŘŜŦŀǳƭǘΣ ŎƘŀƴƴŜƭ мп ƛǎ ǎŜƭŜŎǘŜŘ ǿƛǘƘ ǘƘŜ ǎŀƳŜ 
ǾŀƭǳŜ ŀǎ ǘƘŜ ǇǊƻŎŜǎǎƻǊ ǇǊŜǎŜǘΦ 

YŜŜǇ ǘƘŜ ŎŀōƭŜ ǎǇŜŜŘ ǎƻ ǘƘŀǘ ȅƻǳ Ŏŀƴ ǳǎŜ ǘƘŜ ŘŜŦŀǳƭǘ ŎƭƻŎƪ ŘƛǾƛŘŜǊΦ 

bƻǘŜΥ ̧ƻǳ ƴŜŜŘ ǘƻ ǊŜǇŜŀǘ ǘƘŜ 5ŜǘŜŎǘ /ŀōƭŜ ŀƴŘ {Ŏŀƴ 5ŜǾƛŎŜ ǎǘŜǇǎ ƛŦ ȅƻǳ ƘŀǾŜ ǇƭǳƎƎŜŘ ƻǊ ǳƴǇƭǳƎƎŜŘ ǘƘŜ ŎŀōƭŜΦ 
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Figure 3.39. CableConn Tab of Debug Configurations 

6. {ŜƭŜŎǘ ǘƘŜ 5ŜōǳƎƎŜǊ ǘŀō όCƛƎǳǊŜ оΦплύΦ Lǘ ƛǎ ŎǊƛǘƛŎŀƭ ǘƘŀǘ ǘƘŜ /ƻƴŦƛƎ ƻǇǘƛƻƴǎ ŦƛŜƭŘ Ŏƻƴǘŀƛƴǎ ǘƘŜ ŎƻǊǊŜŎǘ ŎƻƳƳŀƴŘ ƭƛƴŜ 
ƻǇǘƛƻƴǎ ǘƻ ōŜ ǇŀǎǎŜŘ ǘƻ hǇŜƴh/5Φ 

-c "set port ${PORT}" is required for the selection connected to the Lattice cable. The value of the variable 
ά${PORT}έ comes from the cable settings of the CableConn tab. 

-c "set target ${DEVICE}" is required for the selection of a specific device on the Lattice cable. The value of the 
ǾŀǊƛŀōƭŜ ά${DEVICE}έ comes from the device settings of CableConn tab. 

-c άset channel ${CHANNEL}έ is required for setting the JTAG channel. The value of the variable ά${CHANNEL}έ 
comes from the jtag channel setting of the CableConn tab. 

-c "set tck ${TCKDIV}" is required for setting the clock divider of the Lattice cable. The value of the variable 
ά${TCKDIV}έ comes from the speed setting of the CableConn tab. 
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Figure 3.40. Debugger Tab of Debug Configurations 

7. όhǇǘƛƻƴŀƭύ {ŜƭŜŎǘ ǘƘŜ /ƻƳƳƻƴ ǘŀō όCƛƎǳǊŜ оΦпмύΦ ¢ƘŜ {ŀǾŜ ŀǎ Ҕ [ƻŎŀƭ ŦƛƭŜ ƻǇǘƛƻƴ ƛǎ ǎŜƭŜŎǘŜŘ ōȅ ŘŜŦŀǳƭǘΦ ¢Ƙƛǎ ŎŀǳǎŜǎ 
ǘƘŜ ŘŜōǳƎ ƭŀǳƴŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǘƻ ōŜ ǎŀǾŜŘ ƛƴǘƻ ǘƘŜ ǿƻǊƪǎǇŀŎŜΦ  

¸ƻǳ Ŏŀƴ ŎƘŀƴƎŜ ǘƘŜ ǎŜǘǘƛƴƎ ƻŦ ǘƘŜ {ŀǾŜ ŀǎ ŦƛŜƭŘ ǘƻ {ƘŀǊŜŘ ŦƛƭŜΦ Lƴ ǘƘƛǎ ǿŀȅΣ ǘƘŜ ŘŜōǳƎ ƭŀǳƴŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƛǎ ǎŀǾŜŘ 
ƛƴǘƻ ǘƘŜ ǇǊƻƧŜŎǘ ŀƴŘ ǘƘƛǎ ŀƛŘǎ ǘƘŜ ǇǊƻƧŜŎǘ ǇƻǊǘŀōƛƭƛǘȅΦ 

  

Figure 3.41. Common Tab of Debug Configurations 

http://www.latticesemi.com/legal


Lattice Propel 2025.2 SDK  
User Guide 
 

© 2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02244-1.0  45 

8. wŜƳŀƛƴ ǎŜǘǘƛƴƎǎ ŀǎ ŘŜŦŀǳƭǘΦ 5ƻ ƴƻǘ ŎƘŀƴƎŜ ǘƘŜ ǎŜǘǘƛƴƎǎ ǳƴƭŜǎǎ ƴŜŎŜǎǎŀǊȅΣ ƻǊ ǳƴƭŜǎǎ ȅƻǳ ǳƴŘŜǊǎǘŀƴŘ ǿƘŀǘ ŜŦŦŜŎǘ 
ǘƘŜǎŜ ŎƘŀƴƎŜǎ Ƴŀȅ ōǊƛƴƎΦ 

9. /ƭƛŎƪ !ǇǇƭȅ ǘƻ ƪŜŜǇ ǘƘŜ ŎǳǊǊŜƴǘ ǎŜǘǘƛƴƎǎΦ 

10. /ƭƛŎƪ /ƭƻǎŜΦ  

bƻǘŜΥ .ȅ ŘŜŦŀǳƭǘΣ /κ/ҌҌ !ǇǇƭƛŎŀǘƛƻƴΣ /κ/ҌҌ !ǘǘŀŎƘ ǘƻ !ǇǇƭƛŎŀǘƛƻƴΣ /κ/ҌҌ tƻǎǘƳƻǊǘŜƳ 5ŜōǳƎƎŜǊΣ /κ/ҌҌ wŜƳƻǘŜ 
!ǇǇƭƛŎŀǘƛƻƴΣ /κ/ҌҌ ¦ƴƛǘΣ ŀƴŘ D5. IŀǊŘǿŀǊŜ 5ŜōǳƎƎƛƴƎ ŀǊŜ ƘƛŘŘŜƴ ƻƴ ǘƘŜ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎ ǇŀƎŜΦ LŦ ȅƻǳ ǿŀƴǘ ǘƻ 
ǳǎŜ ǘƘŜƳΣ ȅƻǳ Ŏŀƴ ŘƛǎŀōƭŜ CƛƭǘŜǊ ŎƘŜŎƪŜŘ ƭŀǳƴŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǘȅǇŜǎ όCƛƎǳǊŜ оΦпнύΦ 

 

Figure 3.42. Launch Configurations 

3.5.2. Starting a Debug Session 

Before starting a debug session, be sure that: 

¶ The Lattice cable is connected to the computer. 

¶ The target device is powered ON. 

¶ The hardware design has a debug enabled processor module and already programmed into the target device. 

With the above steps completed properly, follow steps below to start the debug session from Lattice Propel SDK. 

1. /ƘƻƻǎŜ wǳƴ Ҕ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧΦ 

2. LŦ ƴŜŎŜǎǎŀǊȅΣ ŜȄǇŀƴŘ ǘƘŜ D5. hǇŜƴh/5 5ŜōǳƎƎƛƴƎ ƎǊƻǳǇΦ 

3. {ŜƭŜŎǘ ǘƘŜ ƴŜǿƭȅπŘŜŦƛƴŜŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ 

4. /ƭƛŎƪ ǘƘŜ 5ŜōǳƎ ōǳǘǘƻƴ όCƛƎǳǊŜ оΦпмύΦ  

!ƭǘŜǊƴŀǘƛǾŜƭȅΣ ŦƻǊ ƭŀǘŜǊ ǎŜǎǎƛƻƴǎΣ ǳǎŜ ǘƘŜ 5ŜōǳƎ ƛŎƻƴ  ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ 5ƻ ƴƻǘ ŎƭƛŎƪ ǘƘŜ 5ŜōǳƎ ƛŎƻƴ ŘƛǊŜŎǘƭȅΦ LƴǎǘŜŀŘΣ 
ŎƭƛŎƪ ǘƘŜ Řƻǿƴ ŀǊǊƻǿ ōŜǎƛŘŜ ǘƘŜ 5ŜōǳƎ ƛŎƻƴΦ {ŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ŘŜōǳƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ŦǊƻƳ ǘƘŜ ŘǊƻǇπŘƻǿƴ ƳŜƴǳ 
όCƛƎǳǊŜ оΦпоύΦ 
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Figure 3.43. Debug Icon on Toolbar 

5. ²ŀƛǘ ŦƻǊ ŀ ŦŜǿ ǎŜŎƻƴŘǎ ǘƻ ǎǿƛǘŎƘ ǘƻ ŘŜōǳƎ ǇŜǊǎǇŜŎǘƛǾŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ǎŜǊǾŜǊΣ ŎƻƴƴŜŎǘƛƴƎ ǘƻ ǘƘŜ ǘŀǊƎŜǘ ŘŜǾƛŎŜΣ ǎǘŀǊǘƛƴƎ 
ǘƘŜ ƎŘō ŎƭƛŜƴǘΣ ŘƻǿƴƭƻŀŘƛƴƎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΣ ŀƴŘ ǎǘŀǊǘƛƴƎ ǘƘŜ ŘŜōǳƎƎƛƴƎ ǎŜǎǎƛƻƴΦ  

6. ¢ƘŜ [ŀǘǘƛŎŜ tǊƻǇŜƭ ²ƛƴŘƻǿ ŘƛǎǇƭŀȅǎΣ ŀǎ ǎƘƻǿƴ ƛƴ CƛƎǳǊŜ оΦппΦ ¢ƘŜ ŜȄŜŎǳǘƛƻƴ ǎǘƻǇǎ ǊƛƎƘǘ ŀǘ ǘƘŜ ōŜƎƛƴƴƛƴƎ ƻŦ ǘƘŜ 
Ƴŀƛƴόύ ŦǳƴŎǘƛƻƴΦ 

 

Figure 3.44. Debug Perspective 1 

Note: If you need to do Reveal and Lattice Propel On-Chip Debugging concurrently, it is recommended to launch Lattice 
Propel SDK On-Chip Debugging first before launching Reveal. 

3.5.3. Peripherals Registers View 

The Peripherals registers view provides an easy-to-use interface for examining or modifying the values of peripheral 
registers during a debug session. 

To use peripherals registers view in Lattice Propel SDK (Figure 3.45): 

1. aŀƪŜ ǎǳǊŜ ŀƴ ŀŎǘƛǾŜ ŘŜōǳƎ ǎŜǎǎƛƻƴ ƛǎ Ǌǳƴ ŀƴŘ ǎƘƻǿƴ ƛƴ ǘƘŜ ŘŜōǳƎ ǇŜǊǎǇŜŎǘƛǾŜΦ 

2. CƛƴŘ ǘƘŜ tŜǊƛǇƘŜǊŀƭǎ ǾƛŜǿ ǿƘƛŎƘ ƛǎ ƛƴ ǘƘŜ ǎŀƳŜ ǿƛƴŘƻǿ ǿƛǘƘ ǘƘŜ ±ŀǊƛŀōƭŜǎ ŀƴŘ .ǊŜŀƪǇƻƛƴǘǎ ǾƛŜǿǎΦ CƻǊ ŀƴȅ ǊŜŀǎƻƴΣ 
ƛŦ ǘƘƛǎ ǾƛŜǿ ƛǎ ƴƻǘ ŦƻǳƴŘΣ ǊŜπƻǇŜƴ ƛǘ ŦǊƻƳ ²ƛƴŘƻǿ Ҕ {Ƙƻǿ ±ƛŜǿ Ҕ tŜǊƛǇƘŜǊŀƭǎΦ 

¢ƘŜ tŜǊƛǇƘŜǊŀƭǎ ǾƛŜǿ ƭƛǎǘǎ ŀƭƭ ǇŜǊƛǇƘŜǊŀƭǎ ŀǾŀƛƭŀōƭŜ ƛƴ ǘƘŜ ǎȅǎǘŜƳ ǾƛŜǿ ŘŜǎŎǊƛǇǘƛƻƴ ǎǾŘ ŦƛƭŜ ǿƛǘƘƛƴ ǘƘŜ /κ/ҌҌ tǊƻƧŜŎǘΦ 

3. {ŜƭŜŎǘƛƴƎ ŀ ǇŜǊƛǇƘŜǊŀƭ ƛƴ ǘƘŜ tŜǊƛǇƘŜǊŀƭǎ ǾƛŜǿ Ŏŀƴ ƻǇŜƴ ŀ aŜƳƻǊȅ aƻƴƛǘƻǊ ǘƘŀǘ ƛǎ ƳŀǇǇŜŘ ǘƻ ǘƘŜ ŎƻǊǊŜǎǇƻƴŘƛƴƎ 
ǇŜǊƛǇƘŜǊŀƭ ƳŜƳƻǊȅ ŀǊŜŀΦ 

4. ¸ƻǳ Ŏŀƴ ŜȄŀƳƛƴŜ ŀƴŘ ƳƻŘƛŦȅ ǘƘŜ ǾŀƭǳŜ ƻŦ ǘƘŜ ǇŜǊƛǇƘŜǊŀƭǎ ǊŜƎƛǎǘŜǊ ƛƴ ǘƘŜ aŜƳƻǊȅ ǾƛŜǿΦ  
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Figure 3.45. Peripherals View in Debug Perspective 

3.5.4. Serial Terminal Tool ς Windows  

Serial port communication is frequently used during microcontroller debugging. Lattice Propel SDK provides a  
built-in terminal tool including serial support for debugging. 

To launch a serial terminal: 

1. CƛƴŘ ǘƘŜ ¢ŜǊƳƛƴŀƭ ǾƛŜǿ ƴŜǎǘŜŘ ǘƻ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿΦ LŦ ǘƘƛǎ ǾƛŜǿ ƛǎ ƴƻǘ ŦƻǳƴŘΣ ǊŜπƻǇŜƴ ƛǘ ŦǊƻƳ ²ƛƴŘƻǿ Ҕ {Ƙƻǿ ±ƛŜǿ 
Ҕ ¢ŜǊƳƛƴŀƭΦ 

2. Lƴ ǘƘŜ ¢ŜǊƳƛƴŀƭ ǾƛŜǿΣ ŎƭƛŎƪ ǘƘŜ hǇŜƴ ŀ ¢ŜǊƳƛƴŀƭ ƛŎƻƴ  Φ ¢ƘŜ [ŀǳƴŎƘ ¢ŜǊƳƛƴŀƭ ŘƛŀƭƻƎ ƻǇŜƴǎ όCƛƎǳǊŜ оΦпсύΦ 

3. /ƘƻƻǎŜ {ŜǊƛŀƭ ¢ŜǊƳƛƴŀƭ ŀƴŘ ŎƻƴŦƛƎǳǊŜ ǘƘŜ {ŜǊƛŀƭ ǇƻǊǘ ǿƛǘƘ .ŀǳŘ ǊŀǘŜΦ 

 

Figure 3.46. Launch Terminal Dialog 1 
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4. /ƭƛŎƪ hYΦ ! ŎƻƴƴŜŎǘƛƻƴ ƻǇŜƴǎΦ 

5. όhǇǘƛƻƴŀƭύ /ƭƛŎƪ ǘƘŜ ¢ƻƎƎƭŜ /ƻƳƳŀƴŘ LƴǇǳǘ ƛŎƻƴ ǘƘŀǘ ŀŘŘǎ ŀƴ ŜŘƛǘ ōƻȄ ǘƻ ŜƴǘŜǊ ǘŜȄǘ όCƛƎǳǊŜ оΦптύΦ 

 

Figure 3.47. Terminal View 

3.5.5. Serial Terminal Tool ς Linux  

In Linux, the VCP driver and D2XX driver are incompatible with each other. For more details, refer to FTDI Drivers 
Installation Guide for Linux. 
Lattice Propel SDK 2025.2 provides a Linux terminal tool to fix this compatibility limitation, based on PyFtdi. 

To launch a serial terminal: 

1. CƛƴŘ ǘƘŜ ¢ŜǊƳƛƴŀƭ ǾƛŜǿ ƴŜǎǘŜŘ ǘƻ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿΦ LŦ ǘƘƛǎ ǾƛŜǿ ƛǎ ƴƻǘ ŦƻǳƴŘΣ ǊŜπƻǇŜƴ ƛǘ ŦǊƻƳ ²ƛƴŘƻǿ Ҕ {Ƙƻǿ ±ƛŜǿ 
Ҕ ¢ŜǊƳƛƴŀƭΦ  

2. Lƴ ǘƘŜ ¢ŜǊƳƛƴŀƭ ǾƛŜǿΣ ŎƭƛŎƪ ǘƘŜ hǇŜƴ ŀ ¢ŜǊƳƛƴŀƭ ƛŎƻƴ Φ ¢ƘŜ [ŀǳƴŎƘ ¢ŜǊƳƛƴŀƭ ŘƛŀƭƻƎ ƻǇŜƴǎ όCƛƎǳǊŜ оΦпуύΦ 

3. /ƘƻƻǎŜ [ƻŎŀƭ ¢ŜǊƳƛƴŀƭ ŀƴŘ ǘƘŜ ŘŜŦŀǳƭǘ ŜƴŎƻŘƛƴƎ ¦¢CπуΦ  

 

Figure 3.48. Launch Terminal Dialog 2 

4. /ƭƛŎƪ hYΦ ! [ƛƴǳȄ ǎƘŜƭƭ ŎƻƳƳŀƴŘ ǿƛƴŘƻǿ ƻǇŜƴǎΦ 

LƴǇǳǘ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŎƻƳƳŀƴŘΦ 

¢ƘŜƴ ƛƴǇǳǘ ǘƘŜ ŘŜǾƛŎŜ ƛƴŘŜȄΣ ŀǎ ǎǳƎƎŜǎǘŜŘ ƛƴ ǘƘŜ ǘŜǊƳƛƴŀƭ όCƛƎǳǊŜ оΦпфύΦ 

9ȄŜŎǳǘŜ ƻƴπŎƘƛǇ ŘŜōǳƎ ǿƛǘƘ ǘƘŜ ¦!w¢ ƻǳǘǇǳǘ όCƛƎǳǊŜ оΦрлύΦ 

bƻǘŜΥ aŀƪŜ ǎǳǊŜ ǘƻ ǎŜƭŜŎǘ ǘƘŜ ŎƻǊǊŜŎǘ C¢5L ŘŜǾƛŎŜ ǎƘƻǿƴ ƛƴ CƛƎǳǊŜ оΦпфΦ hǘƘŜǊǿƛǎŜΣ ƻƴπŎƘƛǇ ŘŜōǳƎ ŦŀƛƭǳǊŜ Ŏŀƴ ƻŎŎǳǊ 
ŀƴŘ ȅƻǳ ƴŜŜŘ ǘƻ ǊŜπƭŀǳƴŎƘ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΦ  

$cd < Propel SDK install Location>  

$./terminal_cli  
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Figure 3.49. Terminal cli 

 

Figure 3.50. On-Chip Debug with UART Output 
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4. How to Start with Lattice FPGA Board 
This chapter is a tutorial on how to run a program on a Lattice FPGA board. 

This tutorial uses CertusPro-NX Evaluation Board for example. 

All Lattice Propel related products can be found from Lattice Propel Design Environment. 

4.1. Board Introduction 
The CertusPro-NX Evaluation Board features the CertusPro-NX FPGA in the LFG672 package, which is built on Lattice 

Nexusϰ FPGA platform using low power 28 nm FD-SOI technology. The board expands the usability of the CertusPro-NX 
FPGA with FMC HPC connector, PMOD, Raspberry PI, along with access to 8× SerDes channels. 

Easy-to-use board resources of the jumper, LED indicator, push button and switch are available for user-defined 

applications. Refer to CertusPro-NX Evaluation Board User Guide (FPGA-EB-02046) for more details of this board.  
Figure 4.1 shows the top view of the CertusPro-NX Evaluation Board.  

 

Figure 4.1. CertusPro-NX Evaluation Board 
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4.2. Creating an SoC Project 
The first step is to Create an SoC project. The SoC project is the hardware environment for a program. For detailed flow 
for creating an SoC project, refer to Lattice Propel Builder 2025.2 User Guide (FPGA-UG-02243). 

From Lattice Propel Builder, you can create scalable SoC projects and other special SoC projects (Figure 4.2). 

Note: In this document, most of the guided flow is based on scalable SoC projects. 

In the Select Device GUI, select the corresponding board (Figure 4.3). In this example, CertusPro-NX Evaluation Board is 
selected. 

 

Figure 4.2. Select Template GUI 
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Figure 4.3. Select Device GUI 

4.3. Creating a C/C++ Project 
The second step is to create a C/C++ project. 

Refer to the C/C++ Project Design Flow section for details of creating a C/C++ project. 

Different C project templates need different types of SoC project. 

4.4. Memory Initialization (Optional) 
The third step is to initialize the memory file for the SoC project. 

This step is optional. If you need the board to run after power-on, you need to execute this step. 

Refer to the Memory Initialization to SoC Project section for memory initialization details. 

4.5. Generating and Programing a Bit File 
The fourth step is to generate a bit file and program it to board. 

Save the SoC project created in steps above. Launch the Lattice Radiant software or Lattice Diamond software to 
generate the bit file, as shown in the Opening a Design in Lattice FPGA Design Software section. 

When the bit file is generated correctly, program it to the board. Refer to the corresponding board user guide for 
details of programming the bit file. In this example, refer to CertusPro-NX Evaluation Board User Guide  
(FPGA-EB-02046). 

4.6. On-Chip Debugging 
The last step is on-chip debugging. You can refer to the Programming and On-Chip Debugging Flow section. 
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5. General Application Templates 

5.1. Template List and Requirements 
General application templates provide reference code for RISC-V processors. 

These general templates depend on scalable RISC-V SoC projects. 

For the project flow, refer to the How to Start with Lattice FPGA Board section. 

Table 5.1 lists all the general templates and displays the requirements for every template. 

Table 5.1. Template List 

Template Name 
Processor Requirement 

(Minimal Supported Version) 
Required IP Other Requirement Default Soc Project 

Hello World Project 

RISC-V RX (V2.2.0), 

RISC-V MC (V2.4.0), 

RISC-V SM (V1.4.0), 

RISC-V Nano (V1.0.0) 

UART, 

GPIO 
 τ 

Scalable RISC-V SoC 
Project (RISC-V RX, RISC-V 
MC, RISC-V SM, RISC-V 
Nano) 

FreeRTOS-LTS Minimal 
Project 

RISC-V RX (V2.2.0) UART τ 
Scalable RISC-V SoC 
Project (RISC-V RX) 

FreeRTOS-LTS  
PMP-Blinky Project 

RISC-V RX (V2.2.0) 
UART, 

GPIO  
τ 

Scalable RISC-V SoC 
Project (RISC-V RX) 

RISC-V RX Demo Project RISC-V RX (V2.2.0) UART τ 
Scalable RISC-V SoC 
Project (RISC-V RX) 

I2C Communication 
Project 

RISC-V RX (V2.6.0) 
I2C Target, 

I2C Controller 

For the connection of  
pins, refer to the  
I2C Communication 
Project section.  

Scalable RISC-V SoC 
Project (RISC-V RX) 

SPI Controller Project RISC-V RX (V2.6.0) 
Octal SPI 
Controller 

 τ 
Scalable RISC-V SoC 
Project (RISC-V RX) 

Hardware Interrupt 
Project (PIC) 

RISC-V MC (V2.8.0) UART Enable PIC 
Scalable RISC-V SoC 
Project (RISC-V MC) 

Hardware Interrupt 
Project (PLIC) 

RISC-V RX (V2.6.0) UART Enable PLIC 
Scalable RISC-V SoC 
Project (RISC-V RX) 

Mtimer Project 
RISC-V MC (V2.8.0), 

RISC-V SM (V1.8.0) 
UART Enable Mtimer 

Scalable RISC-V SoC 
Project (RISC-V MC,  
RISC-V SM) 

Real Timer Project RISC-V RX (V2.6.0) UART Enable CLINT 
Scalable RISC-V SoC 
Project (RISC-V RX) 

Software Interrupt 
Project 

RISC-V RX (V2.6.0) UART Enable CLINT 
Scalable RISC-V SoC 
Project (RISC-V RX) 

Watchdog Timer Project RISC-V RX (V2.6.0) UART Enable CLINT 
Scalable RISC-V SoC 
Project (RISC-V RX) 

Code Coverage Project RISC-V RX (V2.4.0) τ 

Enable Semihost 

128 kB memory 
range 

Scalable RISC-V SoC 
Project (RISC-V RX) 

Timing Profiling Project RISC-V RX (V2.4.0) τ 

Enable Semihost 

128 kB memory 
range 

Scalable RISC-V SoC 
Project (RISC-V RX) 

 

5.2. Hello World 
This Hello World C project supports all the scalable RISC-V SoC projects. 
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It requires UART IP for terminal print-out (Figure 5.1) and GPIO IP for LED display. 

 

Figure 5.1. Hello World Project Terminal  

5.3. RTOS 
FreeRTOS-LTS Minimal Project, FreeRTOS-LTS PMP-Blinky Project, and RISC-V RX Demo Project are RTOS application 
templates. 

These templates need the Scalable RISC-V SoC project, Real-Time Operation System (RISC-V RX), as shown in Figure 5.2. 

 

Figure 5.2. Scalable SoC Project ς Real-Time Operation System (RISC-V RX) 

The FreeRTOS-LTS PMP-Blinky Project template shows how to create tasks, timer, and running tasks. When the project 
runs correctly, the terminal print-out is shown in Figure 5.3. 
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Figure 5.3. FreeRTOS-LTS PMP-Blinky Project Terminal Print-out 

5.4. Single Function 
Single function here refers to the corresponding module of each RISC-V processor. The single-function template refers 
ǘƻ ŜŀŎƘ ǇǊƻŎŜǎǎƻǊ ƳƻŘǳƭŜΩǎ ǊŜŦŜǊŜƴŎŜ ŎƻŘŜΦ 

For details of each RISC-V processor and the corresponding module, refer to its IP user guide (Table 5.2).  

Table 5.2. RISC-V Processor User Guide 

RISC-V RX RISC-V RX CPU IP Core 

RISC-V MC RISC-V MC CPU IP Core 

RISC-V SM RISC-V SM CPU IP Core 

RISC-V Nano RISC-V Nano CPU IP Core 

 

5.4.1. Hardware Interrupt Project (PIC) 

This template shows how to use the RISC-V MC ǇǊƻŎŜǎǎƻǊΩǎ Programmable Interrupt Controller (PIC) module. 

This template requires the Scalable RISC-V SoC project, General Micro Controller (RISC-V MC), as shown in Figure 5.4. 

When this project is running, you can push the button mentioned in the corresponding code. Then, you can see the 
terminal print-out (Figure 5.5) and LED display. 

Note: This template supports only three boards by default: CertusPro-NX Evaluation Board, Certus-NX Versa Evaluation 
Board, and CrossLink-NX Evaluation Board. 
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Figure 5.4. Scalable SoC Project ς General Micro Controller (RISC-V MC) 

 

Figure 5.5. Hardware Interrupt Project (PIC) Project Terminal Print-out 

5.4.2. Mtimer Project 

This template shows how to use RISC-V MC processor and RISC-V SM processorΩǎ Mtimer module. 

This template requires the Scalable RISC-V SoC Project, General Micro Controller (RISC-V MC) shown in Figure 5.4, or 
the Scalable RISC-V SoC Project, General Micro Controller (RISC-V SM) shown in Figure 5.6. 

This project uses mtimer for delay function and provides the mdelay() function using the timer cycle counter and the 
irq_mdelay() function using the timer interrupt. The terminal print-out is shown in Figure 5.7. 
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Figure 5.6. Scalable SoC Project ς General State Machine (RISC-V SM) 

 

Figure 5.7. Mtimer Project 

5.4.3. Hardware Interrupt Project (PLIC) 

This template shows how to use the RISC-V RX ǇǊƻŎŜǎǎƻǊΩǎ Platform-Level Interrupt Controller (PLIC) module. 

This template requires the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. 

When this project is running, you can push the button mentioned in the corresponding code. Then, you can see the 
terminal print-out (Figure 5.8) and LED display.  

Note: This template supports only four boards by default: CertusPro-NX Evaluation Board, Certus-NX Versa Evaluation 
Board, CrossLink-NX Evaluation Board, and Avant-E Evaluation Board. 

 

http://www.latticesemi.com/legal


Lattice Propel 2025.2 SDK  
User Guide 
 

© 2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02244-1.0  58 

 

Figure 5.8. Hardware Interrupt Project (PLIC) Project Terminal Print-out 

5.4.4. Real Timer Project 

This template shows how to use the RISC-V RX processorΩs CLINT-mtimer module. This timer is a real-time clock of  
32 kHz. 

RTOS projects always use this real-time clock to generate ticks.  

This template requires the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. This project uses the real timer to generate a simple stopwatch. The terminal print-out is shown in  
Figure 5.9.  

 

Figure 5.9. Real Timer Project 

5.4.5. Software Interrupt Project 

This template shows how to use the RISC-V RX processorΩs CLINT-MSIP module.  

This template requires the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. This project uses CLINT-MSIP to generate a simple task scheduler, which act as a multi-thread program. The 
terminal print-out is shown in Figure 5.10. 
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Figure 5.10. Software Interrupt Project 

5.4.6. Watchdog Timer Project 

This template shows how to use the RISC-V RX processorΩs watchdog timer (WDT). 

This template needs the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in Figure 5.2. 

This WDT is a software WDT. It generates a system reset signal when the program goes into endless loop and cannot 
feed the WDT in time.  

Watchdog Timer Project sets a main loop and feeds WDT in every big cycle. There is a simulation busy status, which is 
set by the set_busy_for_demo() function and get by the get_busy_status_for_demo() function. This busy status is like a 
peripheraƭΩǎ status and the program should check its status before using it. 

The terminal print-out is shown in Figure 5.11. 

 

Figure 5.11. Watchdog Timer Project 
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5.5. IP Usage Reference 

5.5.1. I2C Communication Project 

This template needs the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in Figure 5.2. 
This SoC project includes an I2C controller instance and I2C target instance.  

This project requires connecting pins according to the annotation in the main() function. 

When communicating successfully, the terminal print-out is shown in Figure 5.12. I2C controller can send to or get 
message from the existing target at the address 0x31. Communication fails with an invalid target at address 0x32. This 
is expected upon the current design. 

 

Figure 5.12. I2C Communication Project 

5.5.2. SPI Controller Project 

This template requires the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. This SoC project includes the Octal SPI Controller instance. The Octal SPI Controller is designed to be 
connected with an SPI NOR flash.  

This project shows how to use an SPI controller to read or write an SPI NOR flash. 

This project can be created in two forms: read or write between a RAM and a flash; read or write between a file and a 
flash. The different forms depend on the System Library selection in the C project creating flow. 

¶ Read or write between a RAM and a flash 

In the C project creating flow, under the Lattice Toolchain Setting page, select Default for System Library  
(Figure 5.13). The terminal print-out is shown in Figure 5.14.  

The program logic is designed as follows: 

a. Match the flash ID and get the flash size. 

b. Write data to the end of the flash. 

c. Read back the data from the end of the flash. 

d. Compare the data and the report. 
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Figure 5.13. Selecting Default for System Library  

 

Figure 5.14. Read or Write between the RAM and the Flash 

¶ Read or write between a file and a Flash 

In the C project creating flow, under the Lattice Toolchain Setting page, select Semihosting for System Library, 
(Figure 5.15). 

The print-out message shows in the console window (Figure 5.16).  

The program logic is designed as follows: 

a. Match the flash ID and get the flash size. 

b. Read data from the start of the flash and save it into the file flash_use2write.bin. 

c. Write the file flash_use2write.bin to the end of the flash. 

d. Read back the data from the end of flash and save it into the file flash_readback.bin. 

When the program finishes running, you can find the two files, flash_use2write.bin and flash_readback.bin in the 
project folder (Figure 5.17). Compare these two files to verify if the read or write operation is correct. 
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Figure 5.15. Selecting Semihosting System Library  

 

Figure 5.16. Read or Write between File and Flash 
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Figure 5.17. Project Folder 

5.5.3. I3C Communication Project 

This template needs the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in Figure 5.2. 
This SoC project includes an I3C controller instance and I3C target instance.  

This project requires connecting pins according to the annotation in the main() function. 

When communicating successfully, the terminal print-out is shown in Figure 5.18. I3C controller can send to or get 
message from at the address 0x09. 

Figure 5.18. I3C Communication 
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5.5.4. General-Purpose Timer Project 

This template shows how to use the general-purpose timer (GPTIMER) peripheral. 

This template needs the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in Figure 5.2. 

It demonstrates how to initialize, configure, and use a hardware timer to generate periodic interrupts, and how to 
handle those interrupts in software. Running time result is shown in Figure 5.19. 

Key features: 

¶ Initializes the platform, including the Platform-Level Interrupt Controller (PLIC) and trap or exception handlers. 

¶ Configures a general-purpose timer to generate an interrupt every 1 ms. 

¶ Registers the timer interrupt with the PLIC and enables it. 

¶ Provides an interrupt service routine (ISR) for the timer, which sets a flag and prints debug information. 

¶ The main loop waits for the timer interrupt flag and handles it, printing a message each time the timer expires. 

¶ You can set Period Value(ms) in main() to determine the time duration for general purpose timer to overflow. 

Configurable Parameters: 

¶ Timer Period (period_value):  

Adjusts int period_value = 1; in main.c to define the interval between timer events in milliseconds. 

¶ Prescaler Value:  

The pscaler parameter within gp_timer_config() influences the timer's resolution and counting frequency. 

¶ Timer Mode:  

Sets the continuous parameter in gp_timer_config(). 

¶ /ƻƴǘƛƴǳƻǳǎκtŜǊƛƻŘƛŎ aƻŘŜ όŎƻƴǘƛƴǳƻǳǎҐǘǊǳŜύΥ  
¢ƘŜ ǘƛƳŜǊ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ǊŜƭƻŀŘǎ ƛǘǎ ƛƴƛǘƛŀƭ ǾŀƭǳŜ ŀŦǘŜǊ ŜŀŎƘ ǘƛƳŜƻǳǘ ƻǊ ƻǾŜǊŦƭƻǿ ŀƴŘ ŎƻƴǘƛƴǳŜǎ ŎƻǳƴǘƛƴƎΣ 
ǘƘŜǊŜōȅ ƎŜƴŜǊŀǘƛƴƎ ƛƴǘŜǊǊǳǇǘǎ ǊŜǇŜŀǘŜŘƭȅΦ  

¶ hƴŜπǎƘƻǘ aƻŘŜ όŎƻƴǘƛƴǳƻǳǎҐŦŀƭǎŜύΥ  
¢ƘŜ ǘƛƳŜǊ ǎǘƻǇǎ ŀŦǘŜǊ ǘƘŜ ŦƛǊǎǘ ǘƛƳŜƻǳǘ ƻǊ ƻǾŜǊŦƭƻǿ ŜǾŜƴǘΣ ǿƘƛŎƘ Ƴŀȅ ǊŜǎǳƭǘ ƛƴ ƛƴǘŜǊƳƛǘǘŜƴǘ ƻǊ ƴƻ ƛƴǘŜǊǊǳǇǘ 
ǘǊƛƎƎŜǊƛƴƎΦ 

¶ Interrupt Priority: 

The priority parameter in plic_int_register() determines the timer interrupt's priority level. 

¶ Callback Function:  

You can define custom logic to be executed upon a timer interrupt by modifying the function pointer provided to 
gp_timer_start(). 

¶ System Clock (sys_clk):  

The timer's fundamental clock source can be specified in gp_timer_init() to align with the specific hardware setup. 

Configuration Example (Function: gptimer_irq_init_and_start()): 

¶ Determine Counting Direction:  

Configures for Count-down operation, where the timer decrements from the reload value to 0. 

¶ Obtain Prescaler Ratio:  

Determines the actual prescaler ratio by referencing the value of pscaler_ratio[7:0] in the CONTROL register, as 
described in Table 2.14 Prescaler Ratio Table of the Timer/Counter IP User Guide (FPGA-IPUG-02139). 

¶ Calculate Time per Count:  

Time per count = Prescaler Ratio × System clock period 

¶ Calculate Total Time:  

Total time = (Reload Value + 1) × Time per count 

The practice of adding 1 to the reload value ensures a minimum delay guarantee, preventing the actual delay time 
from having a lower bound of 0. 
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In this demo: 

¶ pscaler = 0; // Results in an actual prescaler ratio of 2 ( prescaler = (2 << pscaler)). 

¶ With a target period = 1 ms and sys_clock = 50 MHz, the calculated reload_value is 25,000. This value can also be 
read from the timer. 

¶ The timer counts down from the reload value to 0. 

¶ Time per count = Prescaler Ratio × System clock period. 

¶ Thus, Total timeout = (Reload Value + 1) × Time per count = 1 ms. 

  

Figure 5.19. General Purpose Timer Project 

5.6. Profiling Tool 

5.6.1. Code Coverage Project 

Code coverage is about validating the number of lines of code executed under a test process. This, in turn, helps in 
analyzing how well and comprehensively a software application is being tested. In other words, it is the quantitative 
measurement of the percentage or degree of executed source code of software application during testing. Code 
coverage enables you to gauge the completeness of your test cases more accurately. 

Refer to gcovτa Test Coverage Program for more details. 

This template requires the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. As this template has more code and larger memory size, the corresponding RISC-V RX project created needs 
to have 128 kB Memory Range (Figure 5.22). 

In the C project creating flow, some default selections are different from those of other templates. Keep these default 
selections. 

The print-out log is shown in Figure 5.20. Then, you can find the coverage files in Project Explorer shown in  
Figure 5.21. Double click one of the coverage files and click OK (Figure 5.22).   

Wait for a few seconds, the coverage information is displayed (Figure 5.23). 

For detailed usage of code coverage, refer to Help - Eclipse Platform and enter Gcov View in the Search box.  
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Figure 5.20. Code Coverage Project 

 

Figure 5.21. Code Coverage Files 
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Figure 5.22. Open Coverage Results 

 

Figure 5.23. Code Coverage Information 
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Figure 5.24. Scalable RISC-V SoC Project ς Real-Time Operation System (RISC-V RX) Confirm Page 

5.6.2. How to Add Code Coverage Function to an Existing C Project 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ ŜȄƛǎǘƛƴƎ / ǇǊƻƧŜŎǘΦ 

2. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ tǊƻǇŜǊǘƛŜǎ Ҕ /κ/ҌҌ .ǳƛƭŘ Ҕ {ŜǘǘƛƴƎǎΦ 

3. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / /ƻƳǇƛƭŜǊ Ҕ tǊŜǇǊƻŎŜǎǎƻǊΦ !ŘŘ ǘƘŜ ŘŜŦƛƴŜŘ ǎȅƳōƻƭΣ [{//ψ/h±9w!D9 όCƛƎǳǊŜ рΦнрύΦ 

4. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / /ƻƳǇƛƭŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ !ŘŘ ǘƘŜ ŎƻƳǇƛƭŜǊ ŦƭŀƎΣ πŦǇǊƻŦƛƭŜπŀǊŎǎ πŦǘŜǎǘπŎƻǾŜǊŀƎŜ  
όCƛƎǳǊŜ рΦнсύΦ 

5. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ [ƛōǊŀǊƛŜǎΦ !ŘŘ ǘƘŜ ƭƛōǊŀǊȅΣ ǎƳŀƭƭƎŎƻǾ όCƛƎǳǊŜ рΦнтύΦ  

6. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ !ŘŘ ǘƘŜ ƭƛƴƪŜǊ ŦƭŀƎΣ ππŘŜŦǎȅƳҐψI9!tψ{L½9ҐлȄмллл όCƛƎǳǊŜ рΦнуύΦ 
bƻǘŜΥ лȄмллл ƛǎ ŀ ǎǳƎƎŜǎǘŜŘ ǾŀƭǳŜ ŀƴŘ ƛǘ Ŏŀƴ ōŜ ŎƘŀƴƎŜŘ ǘƻ ŀ ǇǊƻǇŜǊ ǾŀƭǳŜ ƛŦ ƴŜŎŜǎǎŀǊȅΦ 

7. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ /ƘŜŎƪ ƭƛƴƪ ŦƭŀƎǎ ǳƴŘŜǊ ǘƘŜ ƭŀōŜƭΣ hǘƘŜǊ ƭƛƴƪŜǊ ŦƭŀƎǎΦ aŀƪŜ ǎǳǊŜ 
ǘƘŜ ƭƛƴƪŜǊ ŦƭŀƎΣ ππƻǎƭƛōҐǎŜƳƛƘƻǎǘΣ ƛǎ ǎǳǇǇƻǊǘŜŘ όCƛƎǳǊŜ рΦнфύΦ 

8. /ƭƛŎƪ !ǇǇƭȅ ŀƴŘ /ƭƻǎŜΦ 

9. !ŘŘ ǘƘŜ ƭƛƴŜ scoverage_init();  ǘƻ ǘƘŜ ƘŜŀŘ ƻŦ ǘƘŜ ŎƻŘŜ ǎŜŎǘƛƻƴΦ !ŘŘ ǘƘŜ ƭƛƴŜ scoverage_dump();  ǘƻ ǘƘŜ 
ŜƴŘ ƻŦ ǘƘŜ ŎƻŘŜ ǎŜŎǘƛƻƴΦ ̧ƻǳ Ŏŀƴ ǊŜŦŜǊ ǘƻ ǘƘŜ ǎŀƳǇƭŜ ǘŜƳǇƭŀǘŜΦ 

10. wŜōǳƛƭŘ ǘƘƛǎ / ǇǊƻƧŜŎǘΦ 
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Figure 5.25. LSCC_COVERAGE Symbol 

 

Figure 5.26. -fprofile-arcs -ftest-coverage Compiler Flag 
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Figure 5.27. smallgcov Library 

 

Figure 5.28. --defsym=_HEAP_SIZE=0x1000 Linker Flag 
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Figure 5.29. --oslib=semihost Linker Flag 

 

5.6.3. Timing Profiling Project 

Timing profiling is an important aspect of software programming. Through profiling, you can determine the parts in 
program code that are time consuming and need to be re-written. This helps make user program execution faster, 
which is always desired. 

Refer to the GNU gprof document for more details. 

This template requires the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. As this template has more code and larger memory size, the corresponding RISC-V RX project created needs 
to have 128 kB Memory Range (Figure 5.24).  

In this C project creating flow, some default selections are different from other templates. Keep these default 
selections. 

The print-out log is shown in Figure 5.30. Then, you can find the gmon.out file in Project Explorer shown in Figure 5.31. 
Double-click this file (Figure 5.31). Click OK.    

Wait for a few minutes. The gprof Viewer opens (Figure 5.30). 

You can click the icons in the gprof Viewer to change the display style, such as sort samples per function (Figure 5.30). 

You can also click the title of every column to sort (Figure 5.30).  

For detailed usage of gprof Viewer, refer to Help - Eclipse Platform and type in GProf View in the Search box.  
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Figure 5.30. Timing Profiling Project 

 

Figure 5.31. gmon File Viewer 
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Figure 5.32. gprof Viewer 

5.6.4. How to Add Timing Profiling Function to an Existing C Project 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ ŜȄƛǎǘƛƴƎ / ǇǊƻƧŜŎǘΦ 

2. {ŜƭŜŎǘ tǊƻƧŜŎǘ Ҕ tǊƻǇŜǊǘƛŜǎ Ҕ /κ/ҌҌ .ǳƛƭŘ Ҕ {ŜǘǘƛƴƎǎΦ 

3. {ŜƭŜŎǘ 5ŜōǳƎƎƛƴƎΦ 9ƴŀōƭŜ ǘƘŜ DŜƴŜǊŀǘŜ ƎǇǊƻŦ ƛƴŦƻǊƳŀǘƛƻƴ ŎƘŜŎƪōƻȄ όCƛƎǳǊŜ рΦооύΦ  

4. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / /ƻƳǇƛƭŜǊ Ҕ tǊŜǇǊƻŎŜǎǎƻǊΦ !ŘŘ ǘƘŜ ŘŜŦƛƴŜŘ ǎȅƳōƻƭΣ [{//ψDtwhC όCƛƎǳǊŜ рΦопύΦ 

5. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ [ƛōǊŀǊƛŜǎΦ !ŘŘ ǘƘŜ ƭƛōǊŀǊȅΣ ǎƳŀƭƭƎǇǊƻŦ όCƛƎǳǊŜ рΦорύΦ 

6. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ /ƘŜŎƪ ƭƛƴƪ ŦƭŀƎǎ ƛƴ ǘƘŜ ƭŀōŜƭΣ hǘƘŜǊ ƭƛƴƪŜǊ ŦƭŀƎǎΦ aŀƪŜ ǎǳǊŜ ǘƘŜ 
ƭƛƴƪŜǊ ŦƭŀƎΣ ππƻǎƭƛōҐǎŜƳƛƘƻǎǘΣ ƛǎ ǎǳǇǇƻǊǘŜŘ όCƛƎǳǊŜ рΦосύΦ 

7. /ƭƛŎƪ !ǇǇƭȅ ŀƴŘ /ƭƻǎŜΦ  

8. hǇŜƴ ŦƛƭŜ ƭƛƴƪŜǊΦƭŘ ƛƴ ǘƘŜ ǎǊŎ ŦƻƭŘŜǊΦ {Ŝǘ ŀƴ ŜƴƻǳƎƘ ǾŀƭǳŜ ŦƻǊ ψI9!tψ{L½9 όCƛƎǳǊŜ оΦорύΦ  

bƻǘŜΥ ψI9!tψ{L½9 ƛǎ ǘƘŜ ǎƛȊŜ ƻŦ ƘŜŀǇ ƳŜƳƻǊȅΣ ǳǎŜŘ ŦƻǊ ƳŀƭƭƻŎΦ ¢ƛƳƛƴƎ ǇǊƻŦƛƭƛƴƎ ŦǳƴŎǘƛƻƴ ǊŜǉǳƛǊŜǎ ŀŘŘƛǘƛƻƴŀƭ ƘŜŀǇ 
ƳŜƳƻǊȅΦ ¢ƘŜ ǎƛȊŜ ƛǎ ŀǇǇǊƻȄƛƳŀǘŜƭȅ мнр҈κмтр҈ ƻŦ ΦǘŜȄǘ ǎƛȊŜΦ  

9. /ƻǇȅ ƎǇǊƻŦΦŎ ŀƴŘ ƎǇǊƻŦΦƘ ǘƻ ǘƘŜ ǎǊŎ ŦƻƭŘŜǊΦ ¢ƘŜǎŜ ŦƛƭŜǎ Ŏŀƴ ōŜ ŦƻǳƴŘ ƛƴ ǘƘŜ ¢ƛƳƛƴƎ tǊƻŦƛƭƛƴƎ tǊƻƧŜŎǘΦ 

10. 9ƴŀōƭŜ ŀ ƘŀǊŘ ǘƛƳŜǊΦ !ŘŘ ǘƘŜ profile_handler()  ŦǳƴŎǘƛƻƴ ƛƴǘƻ ǘƛƳŜǊ ƘŀƴŘƭŜΦ wŜŦŜǊ ǘƻ ¢ƛƳƛƴƎ tǊƻŦƛƭƛƴƎ tǊƻƧŜŎǘΦ 

11. !ŘŘ ǘƘŜ ƭƛƴŜ gprof_init();  ǘƻ ǘƘŜ ƭƛƴŜ ǿƘŜǊŜ ǘƘŜ ǇǊƻŦƛƭƛƴƎ ǎǘŀǊǘǎΦ !ŘŘ ǘƘŜ ƭƛƴŜ gmon_out();  ǘƻ ǘƘŜ ƭƛƴŜ ǿƘŜǊŜ 
ǘƘŜ ǇǊƻŦƛƭƛƴƎ ǎǘƻǇǎΦ 

12. wŜŦŜǊ ǘƻ ¢ƛƳƛƴƎ tǊƻŦƛƭƛƴƎ tǊƻƧŜŎǘ ŀƴŘ ƳŀƪŜ ǎǳǊŜ ǘƘŜ ŎƻŘŜ ƛǎ ŎƻǊǊŜŎǘΦ 

13. wŜōǳƛƭŘ ǘƘƛǎ / ǇǊƻƧŜŎǘΦ 
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Figure 5.33. Generate gprof Information Checkbox 
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Figure 5.34. LSCC_GPROF Symbol 
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Figure 5.35. smallgprof Link Library 
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Figure 5.36. --oslib=semihost Linker Flag 

 

Figure 5.37. _HEAP_SIZE in Linker Script File 
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6. Lattice Propel Tutorial ς Hello World 
Following this tutorial, you can easily create a hardware and software project. After that, you can run the project on 
your evaluation board.  

The tutorial uses a MachXO3D Breakout Board for demonstration. It uses the RS232 UART function. To enable RS232 
UART function on the MachXO3D Breakout Board, the following reworks on the board are required.  

For more details of this board, refer to MachXO3D Breakout Board User Guide (FPGA-UG-02084). 

1. tŜǊŦƻǊƳ ƘŀǊŘǿŀǊŜ ǊŜǿƻǊƪǎ ƻƴ ǘƘŜ aŀŎƘ·hо5 .ǊŜŀƪƻǳǘ .ƻŀǊŘΦ 

{ƘƻǊǘ wмп ŀƴŘ wмр ǳǎƛƴƎ л Ҡ ǊŜǎƛǎǘƻǊǎΣ ŀǎ ǎƘƻǿƴ ƛƴ CƛƎǳǊŜ сΦмΦ 

 

Figure 6.1. MachXO3D Breakout Board 

2. /ƻƴŦƛƎǳǊŜ ǘƘŜ C¢5L ŘŜǾƛŎŜ ǿƛǘƘ ǘƘŜ C¢ψtǊƻƎ ǎƻŦǘǿŀǊŜ ǘƻ ŜƴŀōƭŜ ǘƘŜ ¦!w¢ ŦǳƴŎǘƛƻƴΦ 

Connect the MachXO3D Breakout Board to the host PC and power on the board. 

Open the FT_Prog software. Select DEVICES > Program. 

Make sure Port B is configured as RS232 UART in Hardware and Virtual COM Port in Driver. See Figure 6.2.  
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Select DEVICES > Program from the FT_Prog software again. From the opened Program Devices dialog, click 
Program.  

 

Figure 6.2. Configuring the FTDI Device 

3. !ƭƭ ǘƘŜ ǊŜǿƻǊƪǎ ŦƻǊ ǘƘŜ aŀŎƘ·hо5 .ǊŜŀƪƻǳǘ .ƻŀǊŘ ŀǊŜ ŎƻƳǇƭŜǘŜŘΦ 

6.1. Creating an SoC Design Project and Preparing Hardware Design 
The MachXO3D Breakout Board includes a minimal volume FPGA, which cannot support an RX SoC project. Hence, an 
MC SoC project is created in this tutorial. 

We need to launch Lattice Propel Builder to create the MC SoC project. 

Follow steps below for a simple SoC creating flow. If you encounter errors, refer to Lattice Propel Builder 2025.2 User 
Guide (FPGA-UG-02243) if meet errors.  

Launch Lattice Propel Builder: 

1. /ƘƻƻǎŜ CƛƭŜ Ҕ bŜǿ {ƻ/ 5ŜǎƛƎƴΦ ǎŜǘ 5ŜǎƛƎƴ LƴŦƻǊƳŀǘƛƻƴ ƻǊ ƭŜŀǾŜ ƛǘ ŀǎ ŘŜŦŀǳƭǘ όCƛƎǳǊŜ сΦоύΦ 
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Figure 6.3. Design Information Settings 

2. /ƭƛŎƪ bŜȄǘΦ /ƘƻƻǎŜ {ŎŀƭŀōƭŜ wL{/π± {ƻ/ tǊƻƧŜŎǘ όCƛƎǳǊŜ сΦпύΦ 

 

Figure 6.4. Select Template Page 

3. /ƭƛŎƪ bŜȄǘΦ /ƘƻƻǎŜ DŜƴŜǊŀƭ aƛŎǊƻ /ƻƴǘǊƻƭƭŜǊ wL{/π± a/ όCƛƎǳǊŜ сΦрύΦ 
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Figure 6.5. Selecting General Micro Controller RISC-V MC for System Application Level 

4. /ƭƛŎƪ bŜȄǘΦ ¦ǎŜ ǘƘŜ .ƻŀǊŘ ŦƛƭǘŜǊ ŀƴŘ ǎŜƭŜŎǘ aŀŎƘ·hо5 .ǊŜŀƪƻǳǘ όCƛƎǳǊŜ сΦсύΦ 

 

Figure 6.6. Selecting MachXO3D Breakout Board 

5. /ƭƛŎƪ bŜȄǘ ŀƴŘ ŎƭƛŎƪ /ƻƴŦƛǊƳ όCƛƎǳǊŜ сΦтύΦ 
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Figure 6.7. Confirm Page 

6. /ƭƛŎƪ bŜȄǘ ƻƴ ǘƘŜ ŀǊŎƘƛǘŜŎǘǳǊŜ ǇŀƎŜ όCƛƎǳǊŜ сΦуύΦ 

 

Figure 6.8. Architecture Page 

7. /ƭƛŎƪ bŜȄǘ ǘƻ ǾƛŜǿ ǘƘŜ ǇǊƻƧŜŎǘ ƛƴŦƻǊƳŀǘƛƻƴ όCƛƎǳǊŜ сΦфύΦ 
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Figure 6.9. Project Information 

8. /ƭƛŎƪ CƛƴƛǎƘΦ !ƴ {ƻ/ ǇǊƻƧŜŎǘ ƛǎ ŎǊŜŀǘŜŘΣ ŀǎ ǎƘƻǿƴ ƛƴ CƛƎǳǊŜ сΦмлΦ 

 

Figure 6.10. Project Workbench  

6.2. Creating a Hello World C Project 
Creating a C project requires a system environment from an SoC project as input.  

1. Lƴ {ƻ/ ǇǊƻƧŜŎǘ ǿƻǊƪōŜƴŎƘ όCƛƎǳǊŜ сΦмлύΣ /ƘƻƻǎŜ 5ŜǎƛƎƴ Ҕ DŜƴŜǊŀǘŜ Ҕ DŜƴŜǊŀǘŜ ǘƻ ŎǊŜŀǘŜ / ǇǊƻƧŜŎǘ ǊŜǉǳƛǊŜƳŜƴǘ 
ŦƛƭŜǎΦ /ƘƻƻǎŜ 5ŜǎƛƎƴ Ҕ wǳƴ tǊƻǇŜƭ ǘƻ ǎǿƛǘŎƘ ǘƻ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΦ  
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2. Lƴ tǊƻǇŜƭ {5YΣ ǎŜǘ ǘƘŜ ǿƻǊƪǎǇŀŎŜΦ Lƴ ǘƘŜ /κ/ҌҌ ǇǊƻƧŜŎǘ ŎǊŜŀǘƛƴƎ ǇŀƎŜ όCƛƎǳǊŜ сΦммύΣ ǎŜƭŜŎǘ IŜƭƭƻ ²ƻǊƭŘ tǊƻƧŜŎǘΦ 

3. /ƭƛŎƪ bŜȄǘΣ /ƭƛŎƪ CƛƴƛǎƘΦ ¢ƘŜ / ǇǊƻƧŜŎǘ ƛǎ ŎǊŜŀǘŜŘ ŀƴŘ ŘƛǎǇƭŀȅŜŘ ƻƴ ǘƘŜ ǿƻǊƪōŜƴŎƘΦ 

4. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ 

5. /ƘŜŎƪ ǘƘŜ ōǳƛƭŘ ǊŜǎǳƭǘ ŦǊƻƳ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿ όCƛƎǳǊŜ сΦмнύΦ 

 

Figure 6.11. Creating a C/C++ Project 

 

Figure 6.12. Build Result of HelloWorld C Project 
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6.3. Memory Initialization (Optional) 
In the SoC project workbench (Figure 6.10), update the SoC design to set the preloaded software. Enable the Initialize 
Memory checkbox for the System Memory IP instance from the Initialization area of the General tab. Set Initialization 
File (Figure 6.13) generated from the corresponding Hello World C project in the Creating a Hello World C Project 
section. Click Generate (Figure 6.13).   

In the SoC project workbench (Figure 6.10), choose Design > Generate > Generate.  

 

Figure 6.13. Configuring System Memory Module 2 

6.4. Launching Lattice Diamond Software 
Launch the Lattice Diamond software from the created SoC project. To do that: 

1. Lƴ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ǿƻǊƪōŜƴŎƘ όCƛƎǳǊŜ сΦмлύΣ ŎƘƻƻǎŜ 5ŜǎƛƎƴ Ҕ wǳƴ 5ƛŀƳƻƴŘΦ ! [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ǇǊƻƧŜŎǘ ƛǎ ŎǊŜŀǘŜŘ 
ŀƴŘ ƻǇŜƴŜŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƛƴ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ǎƻŦǘǿŀǊŜΦ 

2. {ǿƛǘŎƘ ǘƻ ǘƘŜ tǊƻŎŜǎǎ ǾƛŜǿ ƻŦ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ǇǊƻƧŜŎǘ ŀƴŘ ƳŀƪŜ ǎǳǊŜ .ƛǘǎǘǊŜŀƳ CƛƭŜ ƻǊ W959/ CƛƭŜ ƛǎ ŎƘŜŎƪŜŘ ƛƴ 
ǘƘŜ 9ȄǇƻǊǘ CƛƭŜǎ ǎŜŎǘƛƻƴ όCƛƎǳǊŜ сΦмпύ Φ 

3. /ƘƻƻǎŜ tǊƻŎŜǎǎ Ҕ  wǳƴΦ ²ŀƛǘ ŦƻǊ ƎŜƴŜǊŀǘƛƴƎ ǘƘŜ ǇǊƻƎǊŀƳƳƛƴƎ ŦƛƭŜ ǎǳŎŎŜǎǎŦǳƭƭȅΦ ̧ƻǳ Ŏŀƴ ǎŜŜ ŀ ƎǊŜŜƴ ŎƘŜŎƪƳŀǊƪ 
ōŜŦƻǊŜ ŜŀŎƘ ǎǳŎŎŜǎǎŦǳƭƭȅ ŎƻƳǇƭŜǘŜŘ ǇǊƻŎŜǎǎΦ 

http://www.latticesemi.com/legal


Lattice Propel 2025.2 SDK  
User Guide 
 

© 2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02244-1.0  86 

  

Figure 6.14. Generating the Programming File 

  

Figure 6.15. Generating the Programming File Successfully 

6.5. Programming the Target Device 
Once the programming file is exported successfully in the last section (Figure 6.15), you can program the target device. 
Make sure the evaluation board is powered ON and connected correctly to the host PC before performing the following 
procedure. 

1. /ƭƛŎƪ ǘƘŜ tǊƻƎǊŀƳƳŜǊ ƛŎƻƴ    ƻƴ ǘƘŜ ǘƻƻƭōŀǊ ƻŦ ǘƘŜ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ όCƛƎǳǊŜ сΦмрύΦ   
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2. ¢ƘŜ tǊƻƎǊŀƳƳŜǊΥ DŜǘǘƛƴƎ {ǘŀǊǘŜŘ ŘƛŀƭƻƎ ǇƻǇǎ ǳǇ όCƛƎǳǊŜ сΦмсύΦ /ƭƛŎƪ hYΦ  

  

Figure 6.16. Programmer Getting Started Dialog 

3. wŜǾƛŜǿ ǘƘŜ 5ŜǾƛŎŜ CŀƳƛƭȅΣ 5ŜǾƛŎŜΣ hǇŜǊŀǘƛƻƴΣ ŀƴŘ CƛƭŜ bŀƳŜ ƛƴ ǘƘŜ tǊƻƎǊŀƳƳŜǊ ǿƛƴŘƻǿ όCƛƎǳǊŜ сΦмтύΦ 

  

Figure 6.17. Programmer Window 

4. /ƭƛŎƪ ǘƘŜ tǊƻƎǊŀƳ ƛŎƻƴ  ǘƻ ŘƻǿƴƭƻŀŘ ǘƘŜ ǇǊƻƎǊŀƳƳƛƴƎ Řŀǘŀ ŦƛƭŜ ǘƻ ǘƘŜ ŘŜǾƛŎŜΦ 

6.6. Running Demo on the MachXO3D Breakout Board 
1. {ǿƛǘŎƘ ōŀŎƪ ǘƻ [ŀǘǘƛŎŜ tǊƻǇŜƭ {5YΣ ǘƘŜ / ǇǊƻƧŜŎǘ ǿƻǊƪōŜƴŎƘΦ 

2. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ / ǇǊƻƧŜŎǘΣ ǊƛǎŎǾψƳŎψƘŜƭƭƻǿƻǊƭŘΦ 

3. /ƘƻƻǎŜ wǳƴ Ҕ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧΦ 

4. /ƘƻƻǎŜ ǊƛǎŎǾψƳŎψƘŜƭƭƻǿƻǊƭŘ ƛǘŜƳ όCƛƎǳǊŜ сΦмуύΦ 

5. /ƭƛŎƪ ǘƘŜ 5ŜōǳƎ ōǳǘǘƻƴΦ 
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²ŀƛǘ ŦƻǊ ŀ ŦŜǿ ǎŜŎƻƴŘǎ ǘƻ ǎǿƛǘŎƘ ǘƻ ǘƘŜ ŘŜōǳƎ ǇŜǊǎǇŜŎǘƛǾŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ǎŜǊǾŜǊΣ ŀƭƭƻǿƛƴƎ ƛǘ ǘƻ ŎƻƴƴŜŎǘ ǘƻ ǘƘŜ ǘŀǊƎŜǘ 
ŘŜǾƛŎŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ƎŘō ŎƭƛŜƴǘΣ ŘƻǿƴƭƻŀŘƛƴƎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΣ ŀƴŘ ǘƘŜƴ ǎǘŀǊǘƛƴƎ ǘƘŜ ŘŜōǳƎƎƛƴƎ ǎŜǎǎƛƻƴΦ 

bƻǘŜΥ ¢Ƙƛǎ ŘŜƳƻ ǳǎŜǎ ǘƘŜ ŘŜŦŀǳƭǘ ŘŜōǳƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻǇǘƛƻƴǎΦ 

6. LŦ ƘŀǊŘǿŀǊŜ ǊŜǿƻǊƪǎ ƻƴ aŀŎƘ·hо5 ōǊŜŀƪƻǳǘ ōƻŀǊŘ ŘŜǎŎǊƛōŜŘ ƛƴ [ŀǘǘƛŎŜ tǊƻǇŜƭ ¢ǳǘƻǊƛŀƭ ς IŜƭƭƻ ²ƻǊƭŘ ŀǊŜ ŘƻƴŜΣ ȅƻǳ 
Ŏŀƴ ƻǇŜƴ ǘƘŜ ǘŜǊƳƛƴŀƭ ǘƻ ǎŜŜ ǘƘŜ ǇǊƛƴǘπƻǳǘ ƳŜǎǎŀƎŜΦ 

Refer to Serial Terminal Tool ς Windows or Serial Terminal Tool ς Linux. 

  

Figure 6.18. Debug Configurations Dialog 2 

7. /ƭƛŎƪ ǘƘŜ wŜǎǳƳŜ ƛŎƻƴ    ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ ¢ƘŜ ǎŜǊƛŀƭ ǘŜǊƳƛƴŀƭ ƻǳǘǇǳǘ ƛǎ ǎƘƻǿƴ ƛƴ CƛƎǳǊŜ сΦмфΦ 

 

Figure 6.19. Run Result of Hello World Project 
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7. Lattice Propel Tutorial ς CXU Demo 
Composable Extension Unit (CXU) is supported in version 2.5.0 of the RX CPU IP. A CXU is a light-weight, customized 
arithmetic accelerator. With the support of the CXU hardware, you can add custom instructions to deploy CXU 
according to the actual software demand.  

This tutorial uses a CertusPro-NX Evaluation Board with the Secure Hash Algorithm 3 (SHA-3) CXU SoC project for 
demonstration. 

SHA-3 CXU SoC Project template includes a corresponding C project. This C project does software or CXU SHA3-256 
operation and software/CXU Convolutional Neural Network (CNN) convolution operation. Then, it displays the 
performance results. 

This C project also supports timing profiling and code coverage functions. You can enable these functions manually. 

Note: It is recommended that these two functions are not enabled at the same time. 

7.1. Preparing the Hardware and Programming the Target Device ς CXU Demo 
This section introduces how to prepare the hardware and program the target device for the CXU demo project. 

Note: The SoC project templates are gradually being migrated to the new scalable SoC project templates that are only 
available from Lattice Propel Builder. If the following flow for creating an SoC design project is unreachable, create the 
project from Lattice Propel Builder. See Lattice Propel Builder 2025.2 User Guide (FPGA-UG-02243) for more details.  

1. /ǊŜŀǘŜ ŀ {I!πо /·¦ {ƻ/ ǇǊƻƧŜŎǘ ǿƛǘƘ ǘƘŜ /ŜǊǘǳǎtǊƻπb· 9Ǿŀƭǳŀǘƛƻƴ .ƻŀǊŘ όCƛƎǳǊŜ тΦмύΦ /ƭƛŎƪ CƛƴƛǎƘΦ 

2. {ŜƭŜŎǘ tǊƻƧŜŎǘ Ҕ DŜƴŜǊŀǘŜΦ 

3. DŜƴŜǊŀǘŜ ǘƘŜ ǇǊƻƎǊŀƳƛƴƎ ŦƛƭŜ ōȅ ǊǳƴƴƛƴƎ [ŀǘǘƛŎŜ wŀŘƛŀƴǘ ǎƻŦǘǿŀǊŜ ƛƴ ǘƘƛǎ {ƻ/ ǇǊƻƧŜŎǘΦ wŜŦŜǊ ǘƻ ǘƘŜ  
{ƻ/ tǊƻƧŜŎǘ 5ŜǎƛƎƴ Cƭƻǿ ǎŜŎǘƛƻƴ ŦƻǊ ŘŜǘŀƛƭŜŘ ǎǘŜǇǎΦ 

4. tǊƻƎǊŀƳ ǘƘŜ ǇǊƻƎǊŀƳƛƴƎ ŦƛƭŜ ǘƻ ǘƘŜ ǘŀǊƎŜǘ ŘŜǾƛŎŜΣ /ŜǊǘǳǎtǊƻπb· 9Ǿŀƭǳŀǘƛƻƴ .ƻŀǊŘΦ 

 

Figure 7.1. Create SoC Project Wizard  
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7.2. Creating a CXU C Project 
1. The Timing Profiling C project can be created through the Load System and BSP page (CƛƎǳǊŜ тΦн).  

2. Lƴ ǘƘŜ {ȅǎǘŜƳ ŜƴǾ ŦƛŜƭŘΣ ǎŜƭŜŎǘ ǘƘŜ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ŦƛƭŜ ŦǊƻƳ ǘƘŜ /·¦ {ƻ/ ǇǊƻƧŜŎǘ Ƨǳǎǘ ƎŜƴŜǊŀǘŜŘΦ 

3. /ƘŜŎƪ ǘƘŜ / ǇǊƻƧŜŎǘ ƴŀƳŜΦ 

4. /ƭƛŎƪ bŜȄǘΦ /ƭƛŎƪ CƛƴƛǎƘΦ 

 

Figure 7.2. Load System and BSP Page 3 

7.3. Compiling and Running Demo ς CXU Demo 

7.3.1. Compiling C Project ς CXU Demo 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ / ǇǊƻƧŜŎǘΣ ǊƛǎŎǾψǊǘƻǎψ/·¦Φ  

2. {ŜƭŜŎǘ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ 
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7.3.2. Running Demo ς CXU Demo 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ / ǇǊƻƧŜŎǘΣ ǊƛǎŎǾψǊǘƻǎψ/·¦Φ 

2. {ŜƭŜŎǘ wǳƴ Ҕ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧΦ 

3. {ŜƭŜŎǘ ǊƛǎŎǾψǊǘƻǎψ/·¦ ƛƴ D5. hǇŜƴh/5 5ŜōǳƎƎƛƴƎ όCƛƎǳǊŜ тΦоύΦ 

4. /ƭƛŎƪ ǘƘŜ 5ŜōǳƎ ōǳǘǘƻƴΦ 

²ŀƛǘ ŦƻǊ ŀ ŦŜǿ ǎŜŎƻƴŘǎ ǘƻ ǎǿƛǘŎƘ ǘƻ ǘƘŜ ŘŜōǳƎ ǇŜǊǎǇŜŎǘƛǾŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ǎŜǊǾŜǊΣ ŀƭƭƻǿƛƴƎ ƛǘ ǘƻ ŎƻƴƴŜŎǘ ǘƻ ǘƘŜ ǘŀǊƎŜǘ 
ŘŜǾƛŎŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ƎŘō ŎƭƛŜƴǘΣ ŘƻǿƴƭƻŀŘƛƴƎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΣ ŀƴŘ ǘƘŜƴ ǎǘŀǊǘƛƴƎ ǘƘŜ ŘŜōǳƎƎƛƴƎ ǎŜǎǎƛƻƴΦ 

bƻǘŜΥ ¢Ƙƛǎ ŘŜƳƻ ǳǎŜǎ ǘƘŜ ŘŜŦŀǳƭǘ ŘŜōǳƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻǇǘƛƻƴǎΦ 

 

Figure 7.3. Debug Configurations Dialog 3 

5. CƛƴŘ ǘƘŜ ¢ŜǊƳƛƴŀƭ ǾƛŜǿ ƴŜǎǘŜŘ ǘƻ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿΦ LŦ ǘƘƛǎ ǾƛŜǿ ƛǎ ƴƻǘ ŦƻǳƴŘΣ ǊŜπƻǇŜƴ ƛǘ ŦǊƻƳ ²ƛƴŘƻǿ Ҕ {Ƙƻǿ ±ƛŜǿ 
Ҕ ¢ŜǊƳƛƴŀƭΦ 

6. Lƴ ǘƘŜ ¢ŜǊƳƛƴŀƭ ǾƛŜǿΣ ŎƭƛŎƪ ǘƘŜ hǇŜƴ ŀ ¢ŜǊƳƛƴŀƭ ƛŎƻƴ Φ  

7. /ƘƻƻǎŜ ǘƘŜ {ŜǊƛŀƭ ¢ŜǊƳƛƴŀƭ ŀƴŘ ŎƻƴŦƛƎǳǊŜ ǘƘŜ {ŜǊƛŀƭ ǇƻǊǘ ǿƛǘƘ .ŀǳŘ ǊŀǘŜΦ 

Refer to Serial Terminal Tool ς Windows or Serial Terminal Tool ς Linux. 

Note: The serial port number depends on the specific PC. 

8. /ƭƛŎƪ hYΦ ! ǎŜǊƛŀƭ ŎƻƴƴŜŎǘƛƻƴ ŎƻƳƳǳƴƛŎŀǘƛƴƎ ǿƛǘƘ ¦!w¢ ƛǎ ǊŜŀŘȅΦ  

9. /ƭƛŎƪ ǘƘŜ wŜǎǳƳŜ ƛŎƻƴ    ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ ¢ƘŜ ǎŜǊƛŀƭ ǘŜǊƳƛƴŀƭ ƻǳǘǇǳǘǎ ǊǳƴƴƛƴƎ ƭƻƎǎ όCƛƎǳǊŜ тΦпύΦ 

²ŀƛǘ ŦƻǊ ŀ ŦŜǿ ƳƛƴǳǘŜǎΦ ̧ƻǳ Ŏŀƴ ǎŜŜ ǘƘŜ ǇŜǊŦƻǊƳŀƴŎŜ ǊŜǎǳƭǘ ƭƻƎǎ ƛƴ ǘƘŜ ǘŜǊƳƛƴŀƭ όCƛƎǳǊŜ тΦпύΦ 

10. {ŜƭŜŎǘ wǳƴ Ҕ ¢ŜǊƳƛƴŀǘŜ ǘƻ ǎǘƻǇ ǊǳƴƴƛƴƎΦ  
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Figure 7.4. Terminal Logs 

7.4. Using the Timing Profiling Function 
For the details of timing profiling function, you can refer to the How to Add Timing Profiling Function to an Existing C 
Project section.  

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ ŜȄƛǎǘƛƴƎ / ǇǊƻƧŜŎǘΣ ǊƛǎŎǾψǊǘƻǎψ/·¦Φ 

2. {ŜƭŜŎǘ tǊƻƧŜŎǘ Ҕ tǊƻǇŜǊǘƛŜǎ Ҕ /κ/ҌҌ .ǳƛƭŘ Ҕ {ŜǘǘƛƴƎǎΦ 

3. {ŜƭŜŎǘ 5ŜōǳƎƎƛƴƎΦ /ƘŜŎƪ ǘƘŜ DŜƴŜǊŀǘŜ ƎǇǊƻŦ ƛƴŦƻǊƳŀǘƛƻƴ ŎƘŜŎƪōƻȄ όCƛƎǳǊŜ рΦооύΦ  

4. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / /ƻƳǇƛƭŜǊ Ҕ tǊŜǇǊƻŎŜǎǎƻǊΦ !ŘŘ ǘƘŜ ŘŜŦƛƴŜŘ ǎȅƳōƻƭΣ [{//ψDtwhC όCƛƎǳǊŜ рΦопύΦ 

5. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ [ƛōǊŀǊƛŜǎΦ !ŘŘ ǘƘŜ ƭƛōǊŀǊȅΣ ǎƳŀƭƭƎǇǊƻŦ όCƛƎǳǊŜ рΦорύΦ  

6. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ /ƘŜŎƪ ƭƛƴƪ ŦƭŀƎǎ ǳƴŘŜǊ ǘƘŜ ƭŀōŜƭΣ hǘƘŜǊ ƭƛƴƪŜǊ ŦƭŀƎǎΦ aŀƪŜ ǎǳǊŜ 
ǘƘŜ ƭƛƴƪŜǊ ŦƭŀƎΣ ππƻǎƭƛōҐǎŜƳƛƘƻǎǘΣ ƛǎ ǎǳǇǇƻǊǘŜŘ όCƛƎǳǊŜ рΦосύΦ 

7. /ƭƛŎƪ !ǇǇƭȅ ŀƴŘ /ƭƻǎŜΦ  

8. /ƻƳǇƛƭŜ ŀƴŘ Ǌǳƴ ǘƘŜ ŘŜƳƻΣ ŀǎ ǎƘƻǿƴ ƛƴ ǘƘŜ /ƻƳǇƛƭƛƴƎ ŀƴŘ wǳƴƴƛƴƎ 5ŜƳƻ ς /·¦ 5ŜƳƻ ǎŜŎǘƛƻƴΦ ¢ƘŜƴΣ ǘƘŜ ŎƻƴǎƻƭŜ 
ƻǳǘǇǳǘ ƭƻƎǎ όCƛƎǳǊŜ тΦрύΦ 

9. Double-click the file gmon.out to display the gprof Viewer. Refer to the Timing Profiling Project section. 

10. tŀǊǎŜ ǘƘŜ ƎǇǊƻŦ ǊŜǇƻǊǘ όCƛƎǳǊŜ тΦсύΦ 

11. wŜǎǘƻǊŜ ǘƘŜ ǎŜǘǘƛƴƎǎ ŦǊƻƳ ǎǘŜǇ о ǘƻ ǎǘŜǇ сΦ 
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Figure 7.5. Console Logs 1 

 

Figure 7.6. gprof Viewer  

http://www.latticesemi.com/legal


Lattice Propel 2025.2 SDK  
User Guide 
 

© 2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02244-1.0  94 

7.5. Using the Code Coverage Function 
For the details of the timing profiling function, refer to section How to Add Code Coverage Function to an Existing C 
Project. 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ ŜȄƛǎǘƛƴƎ / ǇǊƻƧŜŎǘΣ ǊƛǎŎǾψǊǘƻǎψ/·¦Φ  

2. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ tǊƻǇŜǊǘƛŜǎ Ҕ /κ/ҌҌ .ǳƛƭŘ Ҕ {ŜǘǘƛƴƎǎΦ 

3. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / /ƻƳǇƛƭŜǊ Ҕ tǊŜǇǊƻŎŜǎǎƻǊΦ !ŘŘ ǘƘŜ ŘŜŦƛƴŜŘ ǎȅƳōƻƭΣ [{//ψ/h±9w!D9 όCƛƎǳǊŜ рΦнрύΦ 

4. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / /ƻƳǇƛƭŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ !ŘŘ ǘƘŜ ŎƻƳǇƛƭŜǊ ŦƭŀƎΣ πŦǇǊƻŦƛƭŜπŀǊŎǎ πŦǘŜǎǘπŎƻǾŜǊŀƎŜ  
όCƛƎǳǊŜ рΦнсύΦ  

5. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ [ƛōǊŀǊƛŜǎΦ !ŘŘ ǘƘŜ ƭƛōǊŀǊȅΣ ǎƳŀƭƭƎŎƻǾ όCƛƎǳǊŜ рΦнтύΦ 

6. {ŜƭŜŎǘ Db¦ wL{/π± /Ǌƻǎǎ / [ƛƴƪŜǊ Ҕ aƛǎŎŜƭƭŀƴŜƻǳǎΦ /ƘŜŎƪ ƭƛƴƪ ŦƭŀƎǎ ǳƴŘŜǊ ǘƘŜ ƭŀōŜƭΣ hǘƘŜǊ ƭƛƴƪŜǊ ŦƭŀƎǎΦ aŀƪŜ ǎǳǊŜ 
ǘƘŜ ƭƛƴƪŜǊ ŦƭŀƎΣ ππƻǎƭƛōҐǎŜƳƛƘƻǎǘΣ ƛǎ ǎǳǇǇƻǊǘŜŘ όCƛƎǳǊŜ рΦнфύΦ 

7. /ƭƛŎƪ !ǇǇƭȅ ŀƴŘ /ƭƻǎŜΦ   

8. /ƻƳǇƛƭŜ ŀƴŘ Ǌǳƴ ǘƘŜ ŘŜƳƻΣ ŀǎ ǎƘƻǿƴ ƛƴ ǘƘŜ /ƻƳǇƛƭƛƴƎ ŀƴŘ wǳƴƴƛƴƎ 5ŜƳƻ ς /·¦ 5ŜƳƻ ǎŜŎǘƛƻƴΦ ¢ƘŜƴΣ ǘƘŜ ŎƻƴǎƻƭŜ 
ƻǳǘǇǳǘ ƭƻƎǎ όCƛƎǳǊŜ тΦтύΦ  

9. 5ƻǳōƭŜπŎƭƛŎƪ ƻƴŜ ƻŦ ǘƘŜ ŎƻǾŜǊŀƎŜ ŦƛƭŜǎ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ ƎŎƻǾ ±ƛŜǿŜǊΣ ǊŜŦŜǊ ǘƻ ǘƘŜ /ƻŘŜ /ƻǾŜǊŀƎŜ tǊƻƧŜŎǘ ǎŜŎǘƛƻƴΦ 

10. tŀǊǎŜ ǘƘŜ ƎŎƻǾ ǊŜǇƻǊǘ όCƛƎǳǊŜ тΦуύΦ 

11. wŜǎǘƻǊŜ ǎŜǘǘƛƴƎǎ ƛƴ ǎǘŜǇ о ǘƻ ǎǘŜǇ сΦ 

 

Figure 7.7. Console Logs 2 
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Figure 7.8. gcov Viewer 
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8. Lattice Propel Tutorial ς QEMU 
QEMU is a generic and open-source machine emulator and virtualizer. 

For the detailed manual of QEMU, refer to QEMU ̾  System Emulation. Lattice Propel SDK includes a RISC-V QEMU 

simulator with no hardware required and a QEMU_helloworld template for demonstration. 

8.1. Creating QEMU Hello World C Project 

1. {ŜƭŜŎǘ CƛƭŜ Ҕ bŜǿ Ҕ  [ŀǘǘƛŎŜ /κ/ҌҌ tǊƻƧŜŎǘΦ 

¢ƘŜ /κ/ҌҌ tǊƻƧŜŎǘ ǿƛȊŀǊŘ ƻǇŜƴǎ ǿƛǘƘ ǘƘŜ [ƻŀŘ {ȅǎǘŜƳ ŀƴŘ .{t ǇŀƎŜ όCƛƎǳǊŜ уΦмύΦ 

 

Figure 8.1. Load System and BSP Page 4 

2. {ŜƭŜŎǘ v9a¦ wL{/π± ±ƛǊǘǳŀƭ {ƻ/ {ȅǎǘŜƳ ǳǎƛƴƎ ǘƘŜ ŘǊƻǇπŘƻǿƴ ƳŜƴǳ ƻŦ ǘƘŜ {ȅǎǘŜƳ ŜƴǾ ŦƛŜƭŘ όCƛƎǳǊŜ уΦмύ.  

3. {ŜƭŜŎǘ v9a¦ψƘŜƭƭƻǿƻǊƭŘ tǊƻƧŜŎǘ ŀƴŘ ŎƘŜŎƪ ǘƘŜ ǇǊƻƧŜŎǘ ƴŀƳŜΦ 

4. /ƭƛŎƪ bŜȄǘΦ YŜŜǇ ǘƘŜ ŘŜŦŀǳƭǘ ǎŜǘǘƛƴƎǎ ƛƴ ǘƘŜ [ŀǘǘƛŎŜ ¢ƻƻƭŎƘŀƛƴ {ŜǘǘƛƴƎ ǇŀƎŜΣ ŀǎ {ŜƳƛƘƻǎǘƛƴƎ ƛǎ ǊŜǉǳƛǊŜŘ ŦƻǊ ǘƘŜ ǇǊƛƴǘŦ 
ƻǳǘǇǳǘΦ 

¢ƘŜ / ǇǊƻƧŜŎǘ ƛǎ ŎǊŜŀǘŜŘ ŀƴŘ ŘƛǎǇƭŀȅŜŘ ƻƴ ǘƘŜ ǿƻǊƪōŜƴŎƘΦ 
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5. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ / ǇǊƻƧŜŎǘ Ƨǳǎǘ ŎǊŜŀǘŜŘΣ ǎǇƛƪŜψǉŜƳǳψƘŜƭƭƻǿƻǊƭŘΦ 

6. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ 

7. /ƘŜŎƪ ǘƘŜ ōǳƛƭŘ ǊŜǎǳƭǘ ŦǊƻƳ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿ όCƛƎǳǊŜ уΦнύΦ 

 

Figure 8.2. Build Console  

8.2. Running QEMU C Project 
1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ǘƘŜ / ǇǊƻƧŜŎǘ Ƨǳǎǘ ŎǊŜŀǘŜŘΣ ǎǇƛƪŜψǉŜƳǳψƘŜƭƭƻǿƻǊƭŘΦ 

1. /ƘƻƻǎŜ wǳƴ Ҕ 5ŜōǳƎ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧΦ 

2. /ƘƻƻǎŜ ǎǇƛƪŜψǉŜƳǳψƘŜƭƭƻǿƻǊƭŘ ƛƴ D5. v9a¦ 5ŜōǳƎƎƛƴƎ όCƛƎǳǊŜ уΦоύΦ 

3. /ƭƛŎƪ ǘƘŜ 5ŜōǳƎ ōǳǘǘƻƴΦ 

²ŀƛǘ ŦƻǊ ŀ ŦŜǿ ǎŜŎƻƴŘǎ ǘƻ ǎǿƛǘŎƘ ǘƻ ǘƘŜ ŘŜōǳƎ ǇŜǊǎǇŜŎǘƛǾŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ǎŜǊǾŜǊΣ ŀƭƭƻǿƛƴƎ ƛǘ ǘƻ ŎƻƴƴŜŎǘ ǘƻ ǘƘŜ ǘŀǊƎŜǘ 
ŘŜǾƛŎŜΣ ǎǘŀǊǘƛƴƎ ǘƘŜ ƎŘō ŎƭƛŜƴǘΣ ŘƻǿƴƭƻŀŘƛƴƎ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴΣ ŀƴŘ ǘƘŜƴ ǎǘŀǊǘƛƴƎ ǘƘŜ ŘŜōǳƎƎƛƴƎ ǎŜǎǎƛƻƴΦ 

bƻǘŜΥ ¢Ƙƛǎ ŘŜƳƻ ǳǎŜǎ ǘƘŜ ŘŜŦŀǳƭǘ ŘŜōǳƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻǇǘƛƻƴǎΦ  

4. /ƭƛŎƪ ǘƘŜ wŜǎǳƳŜ ƛŎƻƴ    ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ ¢ƘŜ /ƻƴǎƻƭŜ ƻǳǘǇǳǘǎ ǊǳƴƴƛƴƎ ƭƻƎǎ όCƛƎǳǊŜ уΦпύΦ 
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Figure 8.3. Debug Configurations Dialog 4 

 

Figure 8.4. QUMU C Project Running Windows 
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9. Lattice Propel Tutorial ς Bootloader 
A bootloader is a small program that runs immediately after a device powers on or resets and is responsible for loading 
and starting the main operating system or firmware.  

Purpose: The purpose of a bootloader is to Initialize minimal hardware, including CPU, clocks, memory controllers, and 
minimal peripherals. Another purpose is to locate the OS or firmware image, optionally verify its integrity and 
authenticity, and transfer executions to it. 

Examples: U-Boot, coreboot, GRUB for PCs, MCU built-in bootloaders, or small vendor boot ROMs. Use cases range 
from tiny micro-controllers such as single-stage and simple flash loaders, to complex systems like multi-stage 
bootloaders that support network boot, encryption, and advanced update mechanisms. 

These bootloader templates are reference designs for a lattice SoC project, whose purpose is to initialize a soft IP, 
locate the firmware, verify its integrity, and then transfer executions to it (Figure 9.1). 

There are two modes for you to select: the Bootloader for RAM mode and Bootloader for Execute in Place (XIP) mode.  

 

BSP INIT

Prepare environment for next stage

XIP Mode RAM Mode

Jump to next stage
 

Figure 9.1. Bootloader Purpose 

These templates require the Scalable RISC-V SoC Project, Real-Time Operation System (RISC-V RX), as shown in  
Figure 5.2. 

9.1. Bootloader for RAM Mode 

9.1.1. Prepare the SoC Project 

Launch Lattice Propel Builder to create a Scalable RISC-V SoC Project, choose Real-Time Operation System (RISC-V RX) 
shown in Figure 5.2. Complete creating the project and run the Lattice Radiant software to generate the bit file and 
program for the corresponding device board. 

¢Ƙƛǎ {ƻ/ ǇǊƻƧŜŎǘΩǎ ŀǊŎƘƛǘŜŎǘǳǊŜ ƛǎ shown in Figure 9.2. The memory space is shown in Figure 9.3. 
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CPU

TCM

SPI 
Controller

Other 
Memory

External 
SPI Flash

DATA/INSTR

DATA/INSTR

DATA/INSTR

 

Figure 9.2. SoC Architecture 

tcm_inst/LOCAL_BUS_INSTR

system0_inst/AXI_S0

spi_controller0_inst/AXI4_SUB

0x00000000

0x0000FFFF

0x00200000

0x00207FFF

0x04000000

0x07FFFFFF

 

Figure 9.3. SoC Memory Space 

9.1.2. Prepare the Firmware for RAM Mode 

Upon Figure 9.3, run the firmware code on system0_inst, within the address space 0x00200000 to 0x00207FFF. 

Launch Lattice Propel SDK and create a Lattice C project (Figure 9.4). A HelloWorld project is created for 
demonstration. 

After finishing the creating flow, review the project files in the workspace explorer. You need to change the linker.ld 
file. Change the memory regions to system0_inst (Figure 9.5). 

Select this project, right-click and select Properties to enter settings, enable Create firmware for lattice bootloader, as 
shown in Figure 9.6. Lattice Propel SDK provides this utility to generate a firmware bin file for the Lattice bootloader. 

Build this project, in the  Debug folder, you can find file LSCC_FW_binfile.bin (Figure 9.7). Program this file to the flash. 
As this flash also includes the bit file, you must program the firmware to the free space. Here the offset value is set to 
0x300000 (Figure 9.8). After the programing is completed successfully, the firmware is ready. 
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Figure 9.4. Create the Firmware for RAM Mode ς List 

 

Figure 9.5. Create the Firmware for RAM Mode ς linker.ld 
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Figure 9.6. Create the Firmware ς Settings 
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Figure 9.7. Create the Firmware for RAM Mode ς Firmware File 

 

Figure 9.8. Create the Firmware for RAM Mode ς Program Bin File 
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9.1.3. Create the Bootloader Project for RAM Mode 

Bootloader is the first code that runs after a device powers on or resets, so you must place the bootloader at the reset 
vector address. The default reset vector of the processor is 0x0, which is the tcm0_inst shown in Figure 9.3. 

Launce Lattice Propel SDK and create a Lattice C project. Select Bootloader Launch Firmware from SPI Flash Project 
(Figure 9.9) and click Next to finish.  

 

Figure 9.9. Bootloader for RAM Mode ς List 

Then, build this project and do on-chip debug. The terminal log is shown in Figure 9.10. 

bootloader

firmware information

firmware log

 

Figure 9.10. Bootloader for RAM Mode ς Log 
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9.2. Bootloader for XIP Mode 

9.2.1. Prepare the SoC Project 

The SoC project creating flow is the same as the one shown in the Prepare the SoC Project section. This template only 
supports Winbond SPI Nor flash and the Avant-E Evaluation Board uses the Winbond flash by default. Therefore, the 
Avant-E Evaluation Board is selected in the SoC creating flow. Complete the creating flow and run the Lattice Radiant 
software to generate the bit file and program it to the corresponding device board.  

9.2.2. Prepare the Firmware for XIP Mode 

The XIP mode allows running the program directly in the flash. Upon the memory space shown in Figure 9.3, the code is 
put in spi_controller0_inst, within the address range 0x48000000 to 0x4BFFFFFF, with a offset value. In the bootloader 
for XIP mode, the default offset value is 0x3080000, and the firmware bin file includes a header with a size of 0x1000, 
so the total offset value is 0x3081000. The code address is 0x48000000 + 0x3081000 = 0x4B081000. The data is stored 
in the system0_inst at addresses 0x200000 to 0x207FFF. 

Launch Lattice Propel SDK and create a Lattice C project (Figure 9.11). A FreeRTOS project is created for demonstration. 

After finishing the creating flow, review the project files in the workspace explorer. You need to edit linker.ld file. 
Switch to the edit mode, add an spi_inst memory region, as shown in Figure 9.12 line 12. Save the file and reopen it. 
Then, select different memory regions for the code and data as planned (Figure 9.13). 

Select this project, right-click and select Properties to enter settings. Enable Create firmware for lattice bootloader, as 
shown in Figure 9.6. Lattice Propel SDK provides this utility to generate a firmware bin file for Lattice bootloader. 

Build this project. In the Debug folder, you can find the file LSCC_FW_binfile.bin (Figure 9.14). Program this file to the 
flash. This firmware is for the XIP mode. You must program it to the corresponding flash address as planned. The offset 
must be 0x3080000 (Figure 9.15). After the programing is completed successfully, the firmware is ready. 

 

Figure 9.11. Create the Firmware for XIP Mode ς List 
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Figure 9.12. Create the Firmware for XIP Mode ς linker.ld 1 

 

Figure 9.13. Create the Firmware for XIP Mode ς linker.ld 2 
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Figure 9.14. Create the Firmware for XIP Mode ς Firmware File 

 

Figure 9.15. Create the Firmware for XIP Mode ς Program Bin File 
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